
Working with My webMethods

Version 10.11

October 2021



This document applies to My webMethods Server 10.11 and to all subsequent releases.

Specifications contained herein are subject to change and these changes will be reported in subsequent release notes or new editions.

Copyright © 2004-2023 Software AG, Darmstadt, Germany and/or Software AG USA, Inc., Reston, VA, USA, and/or its subsidiaries
and/or its affiliates and/or their licensors.

The name Software AG and all Software AG product names are either trademarks or registered trademarks of Software AG and/or
Software AGUSA Inc. and/or its subsidiaries and/or its affiliates and/or their licensors. Other company and product namesmentioned
herein may be trademarks of their respective owners.

Detailed information on trademarks and patents owned by Software AG and/or its subsidiaries is located at
https://softwareag.com/licenses/.

Use of this software is subject to adherence to Software AG's licensing conditions and terms. These terms are part of the product
documentation, located at https://softwareag.com/licenses/ and/or in the root installation directory of the licensed product(s).

This software may include portions of third-party products. For third-party copyright notices, license terms, additional rights or
restrictions, please refer to "License Texts, Copyright Notices and Disclaimers of Third Party Products". For certain specific third-party
license restrictions, please refer to section E of the Legal Notices available under "License Terms and Conditions for Use of Software
AG Products / Copyright and Trademark Notices of Software AG Products". These documents are part of the product documentation,
located at https://softwareag.com/licenses/ and/or in the root installation directory of the licensed product(s).

Document ID: MWM-UG-1011-20230517

https://www.softwareag.com/licenses/default.html
https://www.softwareag.com/licenses/default.html
https://www.softwareag.com/licenses/default.html


Table of Contents

About this Guide........................................................................................................................................5
Document Conventions.....................................................................................................................6
Online Information and Support.....................................................................................................7
Data Protection...................................................................................................................................8
Deprecation of webMethods Broker................................................................................................8

1 Logging Into and Logging Out of My webMethods........................................................................9
About Logging Into and Out of My webMethods.......................................................................10
Logging Into My webMethods.......................................................................................................10
Logging Out of My webMethods...................................................................................................11
Changing Your Password................................................................................................................11

2 Familiarizing Yourself with My webMethods................................................................................13
My webMethods User Interface.....................................................................................................14
Standard Links..................................................................................................................................16
Tabs.....................................................................................................................................................16
Navigation Pane...............................................................................................................................18
Application Selections Available in the Navigate Tab................................................................20
Workspace Selections in the Navigate Tab...................................................................................30
Tool Selections in the Tools Tab......................................................................................................30
Format of Application Pages...........................................................................................................34
Format of Workspace Pages............................................................................................................35

3 Viewing and Updating Your My webMethods Profile..................................................................37
The My webMethods Profile..........................................................................................................38
Identifying Yourself to My webMethods......................................................................................38
Exporting Your My webMethods Profile Data.............................................................................40
Generating a Shared Secret for Multi-Factor Authentication....................................................41
Deleting Your My webMethods Profile.........................................................................................41
Setting Your User Preferences........................................................................................................41
Calendars...........................................................................................................................................45

4 Configuring the Time Zone in My webMethods............................................................................47
Changing the Time Zone in My webMethods.............................................................................48

5 Working with My webMethods Workspaces..................................................................................49
About Workspaces............................................................................................................................50
About Creating New Workspaces..................................................................................................50
Defining the Layout of a Workspace.............................................................................................51
Opening Workspaces.......................................................................................................................53
Workspace Properties......................................................................................................................53
Setting General Properties for a Workspace.................................................................................54

Working with My webMethods 10.11 iii



Renaming Workspaces.....................................................................................................................55
Workspace Sharing...........................................................................................................................55
Closing Workspaces.........................................................................................................................59
Deleting Workspaces........................................................................................................................59
About Adding Workspaces to the Navigation Pane...................................................................60

6 Working with Workspace Content.....................................................................................................63
About Workspace Content..............................................................................................................64
Adding Tools to a Workspace.........................................................................................................64
Adding Windows from Application Pages to a Workspace......................................................64
Adding Windows from a Workspace to Another Workspace...................................................66
General Properties for a Window in a Workspace......................................................................67
Viewing Window Properties...........................................................................................................68
Renaming a Window in a Workspace...........................................................................................68
Updating the Description of a Window........................................................................................69
Finding Windows in a Workspace.................................................................................................70
Resizing Windows............................................................................................................................70
Positioning Windows in a Workspace...........................................................................................71
Deleting Windows from a Workspace...........................................................................................72

7 Using Tools to Enhance Workspaces.................................................................................................73
MWS Monitoring and Diagnostics Tools......................................................................................74
Workspace Tools...............................................................................................................................75
Attachments Tool..............................................................................................................................76
Bookmarks Tool................................................................................................................................79
Directory Browser Tool....................................................................................................................82
HTML Text Tool................................................................................................................................83
Image Tool.........................................................................................................................................84
Note Tool............................................................................................................................................86
User Calendar Tool...........................................................................................................................88

8 Searching for Users, Groups, and Roles...........................................................................................91
About Searching for Users, Groups, and Roles............................................................................92
Keyword Searches for Users, Groups, and Roles........................................................................92
Performing a Keyword Search for Users, Groups, or Roles.......................................................93
Advanced Searches for Users and Groups...................................................................................93
Performing an Advanced Search for Users or Groups................................................................94

9 Searching for Data................................................................................................................................95
About Searching for Data................................................................................................................96
Keyword Searches for Data.............................................................................................................98
Determining the Fields that Keywords are Searched Against...................................................99
Performing a Keyword Search for Data........................................................................................99
Basic and Advanced Searches for Data.........................................................................................99
Saving Your Search.........................................................................................................................100
Setting Search Options for a My webMethods Page.................................................................102
Defining How My webMethods Displays Search Results........................................................104
Working with Search Results........................................................................................................106

iv Working with My webMethods 10.11

Table of Contents



About this Guide

■   Document Conventions .................................................................................................... 6

■   Online Information and Support ....................................................................................... 7

■   Data Protection ................................................................................................................. 8

■   Deprecation of webMethods Broker ................................................................................. 8

Working with My webMethods 10.11 5



This guide is for users of My webMethods, a web-based administration and monitoring user
interface for managing your webMethods components. It provides procedures for navigating and
using the basic features of My webMethods, including how to access pages for webMethods
components and how to use workspaces.

For a list of webMethods components and associated tasks that are available in My webMethods,
see “Familiarizing Yourself with My webMethods” on page 13. For complete information about
how to perform the tasks that use these webMethods components, see the appropriate guide for
the component. The table that lists the available tasks also includes the titles of the guides where
you can find more information about a tasks.

Document Conventions

DescriptionConvention

Identifies elements on a screen.Bold

Identifies service names and locations in the format folder.subfolder.service, APIs,
Java classes, methods, properties.

Narrowfont

Identifies:Italic

Variables for which you must supply values specific to your own situation or
environment.
New terms the first time they occur in the text.
References to other documentation sources.

Identifies:Monospace font

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the
information inside the curly braces. Do not type the { } symbols.

{ }

Separates two mutually exclusive choices in a syntax line. Type one of these
choices. Do not type the | symbol.

|

Indicates one or more options. Type only the information inside the square
brackets. Do not type the [ ] symbols.

[ ]

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

...
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Online Information and Support

Software AG Documentation Website

You can find documentation on the Software AG Documentation website at https://
documentation.softwareag.com.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to empower@softwareag.comwith
your name, company, and company email address and request an account.

Once you have an account, you can open Support Incidents online via the eService section of
Empower at https://empower.softwareag.com/.

You can find product information on the Software AG Empower Product Support website at
https://empower.softwareag.com.

To submit feature/enhancement requests, get information about product availability, and download
products, go to Products.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, go to the Knowledge Center.

If you have any questions, you can find a local or toll-free number for your country in our Global
Support Contact Directory at https://empower.softwareag.com/public_directory.aspx and give us
a call.

Software AG Tech Community

You can find documentation and other technical information on the SoftwareAGTechCommunity
website at https://techcommunity.softwareag.com. You can:

Access product documentation, if you have Tech Community credentials. If you do not, you
will need to register and specify "Documentation" as an area of interest.

Access articles, code samples, demos, and tutorials.

Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

Link to external websites that discuss open standards and web technology.

Go to our public GitHub andDocker repositories at https://github.com/softwareag and https://
hub.docker.com/u/softwareag and discover additional Software AG resources.
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Data Protection

SoftwareAGproducts provide functionalitywith respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.

Deprecation of webMethods Broker

webMethods Broker is deprecated for use with webMethods 10.2. If you are starting development
usingwebMethods 10.2, you should use SoftwareAGUniversalMessaging instead ofwebMethods
Broker. If you are upgrading to webMethods 10.2, you should consider migrating to Universal
Messaging. If you choose to continue to use webMethods Broker, you will still be fully supported,
but only until the announced end-of-life dates for webMethods Broker. For details, see https://
empower.softwareag.com/brokerendoflife/.
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About Logging Into and Out of My webMethods

MywebMethods is aweb-based,monitoring and administration user interface formanaging your
webMethods components. When you log into My webMethods, you are logging into all
webMethods components that are incorporated into My webMethods. Your user name and
password will be the same for all underlying webMethods components.

For example, if you have and webMethods Optimize for Process installed, when you log into My
webMethods, the system automatically logs you into both webMethods Monitor and Optimize
for Process with a single login. When you log out of My webMethods, My webMethods logs you
out of all underlying webMethods components.

Logging Into My webMethods

My webMethods has a user interface that you access via a web browser.

Important:
Because My webMethods uses JavaScript and cookies, you must ensure that your web browser
is set up to allow cookies and allow JavaScript to execute.

To log into My webMethods

1. Access the My webMethods Login page by entering a URL in a web browser:

http://host:port

where:

host is the host name of the machine on which My webMethods Server is installed.

port is the port onwhichMywebMethods Server listens for incoming requests. The default
port for My webMethods is 8585.

For example, if the host name is rubicon.company.com and it uses the default port (i.e.,
8585), enter the following URL:

http://rubicon.company.com:8585

2. On the Login page, type your My webMethods user name and password. The user name is
case insensitive.

Note:
When logging in, the value you specify in the user name is case insensitive. However, after
logging in, My webMethods uses the case of the user name that is defined in your user
account. For example, if the user account is defined as “Administrator”, you can log in using
“administrator”.WhenMywebMethods needs to use the user name, for example, forHTTP
authentication, it will use the version defined in the user account, which is “Administrator”.

Note:
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For instructions about how to change yourMywebMethods password, see “Changing Your
Password” on page 11.

3. Click Log In.

The first time you log in, My webMethods displays the Welcome workspace. On subsequent
logins, the page My webMethods displays depends on your user preferences. For more
information, see “My webMethods User Preferences” on page 43 and “Setting Your User
Preferences” on page 41.

My webMethods provides an extremely flexible framework for granting or restricting user
access to virtually every aspect of the My webMethods interface. Administrators assign
permissions known as access privileges and functional privileges.

Access privileges define the application pages you can display. If this guide lists pages
and/or menu items that you cannot access, it is likely because you do not have the access
privileges to view the page.

Functional privileges define the actions you can perform inMywebMethods. If this guide
lists user interface controls (for example, buttons) that you do not see, it is likely because
you do not have the functional privileges to perform the actions associated with the user
interface controls.

If you have any questions about your access and functional privileges, talk to your My
webMethods administrator.

Logging Out of My webMethods

Perform the following procedure to log out of My webMethods.

To log out of My webMethods

Click the Logout link, which is located at the top of all My webMethods pages.

Changing Your Password

Change your password by editing the fields on the User Information tab of your profile.

Note:
You can only use this procedure to change your password if the user account is defined in My
webMethods, that is, the “System”directory service. If your user account is defined in an external
directory management system, for example LDAP, you must change the password from the
external directory management system.

To change your My webMethods password

1. Click the My Profile link, which is located at the top of all My webMethods pages.
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2. On the User Information tab, type your new password in the Password field.

3. In the Confirm Password field, type your new password again for confirmation.

4. Click Save.

5. If you do not need to make any further changes to the profile, click on the My Profile tab
to close the page.
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My webMethods User Interface

The following screenshot shows a sample view of the My webMethods user interface:

The following table describes the elements of the My webMethods user interface.

My webMethods always displays the user name of the logged in user at the
top of the page.

logged in user

The standard links provide access to your My webMethods profile and
information about the version of My webMethods and the webMethods

standard links

products in use. There is also a standard link to log out of My
webMethods.My webMethods always displays standard links at the top
right of the page. For more information, see “Standard Links” on page 16.

Click this icon to have My webMethods refresh the navigation pane.refresh icon

This icon hides and restores the navigation pane. For more information, see
“Resizing the Content Area and Navigation Pane” on page 15.

collapse/expand icon

The navigation pane contains two tabs:navigation pane

Navigate tab to provide access to application pages and workspaces.
For more information, see “Navigation Pane” on page 18, “Application
Selections Available in the Navigate Tab” on page 20, and “Workspace
Selections in the Navigate Tab” on page 30.

Tools tab, which lists resources that users can add to workspaces. For
more information, see “Navigation Pane” on page 18 and “Workspace
Tools Section of the Tools Tab” on page 33.

My webMethods displays a tab for each open application page and
workspace. To make an application page or workspace the current page so

tabs

that you can view it, you click its tab. For more information, see “Tabs” on
page 16.
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The New tab allows you to quickly create a new workspace. For more
information, see “Creating New Empty Workspaces” on page 51.

New tab

The tab finder allows you to navigate to open tabs. This control is useful
when you have many open tabs, and as a result, some are not visible. For

tab finder

more information, see “Displaying a Page When its Tab is Not Visible” on
page 17.

The resize icon allows you to resize the navigation pane and content area.
This icon is not always visible. My webMethods displays the resize icon

resize icon

when you place your mouse in the gap between the navigation pane and
the content area. For more information, see “Resizing the Content Area and
Navigation Pane” on page 15.

The areawhereMywebMethods displays the content of an application page
or workspace. For more information, see “Format of Application Pages” on
page 34 and “Format of Workspace Pages” on page 35.

content

Thewindow finder allows you tomake awindow that is open in aworkspace
the current window. This control is useful when you have many open

window finder

windows. Formore information, see “FindingWindows in aWorkspace” on
page 70.

Resizing the Content Area and Navigation Pane
If you need more space for the page content, you can increase its size by reducing the size of the
navigation pane or by completely hiding the navigation pane, allowing the content area to use the
entire width of the web browser window.

To resize the content area and navigation pane

1. To make the content area wider while making the navigation pane narrower:

a. Move your mouse to the gap between the navigation pane and the content area.

My webMethods displays the resize icon, .

b. Click and drag it to the left to increase the size of the content area, while making the
navigation pane narrower.

2. To make the navigation pane wider while making the content area narrower:

a. Move your mouse to the gap between the navigation pane and the content area.

My webMethods displays the resize icon, .
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b. Click and drag it to the right to increase the size of the navigation pane, while making
the content area narrower.

3. To hide the navigation pane completely allowing the content area to use the entire width of
the web browser window, click on the left of the Navigate tab.

4. To restore the navigation pane so that it is visible again, click on the left side of the page.

Standard Links

The following table describes the standard links that appear at the top of every page in My
webMethods.

DescriptionLink

Provides access to your profile. You use your profile to change your password
and specify user information, and preferences. For more information about

My Profile

your profile, see “Viewing and Updating Your My webMethods Profile” on
page 37.

Indicateswhere to finddocumentation for thewebMethods components that
are incorporated into My webMethods.

Help

Lists the version ofMywebMethods and information about thewebMethods
components that are in use with My webMethods.

About

Logs you out of My webMethods. For more information, see “Logging Out
of My webMethods” on page 11.

Logout

Tabs

My webMethods displays tabs above the content area for each open application page and
workspace. The tab lists the name of the application page or workspace.

The following screenshot shows the features of My webMethods tabs.

The following table describes the tabs and tab controls in My webMethods.

My webMethods displays the scroll arrow tabs when the width of the content
area is too narrow to fit the tabs for all open application pages andworkspaces.

scroll left and
scroll right
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Use the arrow tabs to scroll left and right to view additional tabs. For more
information, see “Displaying a Page When its Tab is Not Visible” on page 17.

MywebMethods displays the Close icon on all tabs. Click this icon to close the
application page or workspace, and as a result, remove the tab. For more
information, see “Closing Tabs” on page 17.

close tab

My webMethods displays the menu icon on the current tab. The menu items
that are available will differ based onwhether it is a tab for an application page
or a workspace.

menu

The New tab allows you to quickly create a new workspace. For more
information, see “Creating New Empty Workspaces” on page 51.

New tab

The tab finder allows you to navigate to open tabs. This control is useful when
you have so many open tabs that some are no longer visible. For more
information, see “Displaying a Page When its Tab is Not Visible” on page 17.

tab finder

Closing Tabs
When you no longer need an application page orworkspace open, you can close the tab associated
with that page or workspace.

To close tabs

To close a single tab that is not the current tab, click on the tab you want to close.

To close a single tab that is not currently visible, open the tab finder by clicking and then
click in the tab finder for the tab you want to close.

To close the current tab, you can use either of the above methods, or you click on the current
tab and select Close.

To close all tabs except the current tab, on the current tab click and select Close All Others.

Displaying a Page When its Tab is Not Visible
When you have many application pages and workspaces open, MywebMethods might be unable
to display the tabs for all the open pages. You can display the application page or workspace
associated with a hidden tab by either scrolling the tabs or by using the tab finder control.

To display a page when its tab is not visible

1. If you know that tab is to the left of the currently visible tabs, click the left arrow tab to scroll
the tabs to the left. When the tab for the application page or workspace you want to view is
visible, click it to make it the current page.
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2. If you know that tab is to the right of the currently visible tabs, click the right arrow tab to
scroll the tabs to the right. When the tab for the application page or workspace you want to
view is visible, click it to make it the current page.

3. If you are unsure where the tab is located or want to quickly and easily locate any tab, use the
tab finder:

a. Click the tab finder icon .

b. Select the page you want to view from the list.

Re-arranging the Order of the Tabs
You can re-arrange the tabs by dragging a tab to a new location in the tab list.

Navigation Pane

The navigation pane is on the left side of the user interface. It contains two tabs: the Navigate tab
and the Tools tab.

On the Navigate tab, My webMethods highlights the entry for the application page or workspace
that it is currently displaying in the content area.

The following screenshot shows a sample view of the Navigate tab in My webMethods:
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The Navigate tab has two sections: Applications and Workspaces.

The Applications section provides access to the application pages, and it is further divided into
two sections: the Monitoring section, which lists pages for monitoring webMethods components
and Administration, which lists pages that allow you to administer webMethods components.

The selections in theApplications sectionmight differ based on thewebMethods products installed
and the permissions you are assigned. Additionally, My webMethods administrators can add
custom pages to the navigation. For information about the Applications section, see “Application
Selections Available in the Navigate Tab” on page 20. For information about permissions
management and customizing the navigation, see Administering My webMethods Server.

The Workspaces section provides access to workspaces. You can add entries to the navigation
for workspaces that you have created and/or workspaces that other users have created and have
shared with you. For more information about workspaces, see “Working with My webMethods
Workspaces” on page 49.

The Tools tab lists resources that users can add to workspaces.

The following screenshot shows a sample view of the Tools tab in My webMethods:
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The selections listed in the Tools tab might differ based on the permissions you are assigned.
Additionally, My webMethods developers can add additional tools that are specific to your site.

As installed My webMethods provides tools in the Workspace Tools section of the tab. For
information about the selections in the Workspace Tools section, see “Workspace Tools Section
of the Tools Tab” on page 33. For information about permissions management and customizing
the tools, see Administering My webMethods Server.

Application Selections Available in the Navigate Tab

The selections in theApplications section of theNavigate tab inMywebMethods are determined
by both the following:

webMethods components that are installed.

Functionality towhich you have been granted access. Formore information, seeAdministering
My webMethods Server.

The following sections list the possibleMonitoring andAdministration selections that are available
in the Navigate tab, provides a description of each selection, and indicates the webMethods
component(s) required for My webMethods to include the selection in the navigation pane.

Note:
For a list of the webMethods components you have installed, click the About link, which is one
of the standard links at the top of all My webMethods pages.
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Monitoring Section of the Navigate Tab

The items in the Monitoring section of the Navigate tab depend on the webMethods components,
available in your installation.

Monitoring: System-Wide

The following table lists the items, available in the System-Wide menu and the components that
each item requires.

Required componentsItem

Optimize for ProcessProblems to locate problemswith process instances
and to view information related to the KPI rules

Optimize for Processthat a process instance has violated. Additionally,
For more information, see webMethods
Optimize User’s Guide.

use Problems to view problems where system
components are out of compliance and to view
information about the event rules and threshold
rules that were violated.

Optimize for InfrastructureAnalytics Overview to view a summary of all
system components. Use this task to view the
performance of the entire system at a high level. Optimize for Process

For more information, see webMethods
Optimize User’s Guide.

Monitoring: Business

The following table lists the items, available in the Business menu and the components that each
item requires.

Required componentsItem

Task EngineCollaboration Processes to search for and view
currently running collaborationprocesses that users
start when creating a collaboration task. For more information, see webMethods Task

Engine User’s Guide.

Optimize for ProcessProcess Analytics to analyze information about
the performance of processes.

For more information, see webMethods
Optimize User’s Guide.

Optimize for B2BBusiness Overview to monitor and analyze
Trading Networks transaction data.

For more information, see webMethods
Optimize for B2B User’s Guide.
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Required componentsItem

MonitorProcess Instances to view details about
individual process instances, including drilling

Optimize for Processdown to view information about steps within a
For more information, see the webMethods
Monitor User’s Guide or webMethods Optimize
User’s Guide.

process. You can also use this link to suspend and
resume processes.

Trading NetworksTasks to view and manage tasks in My
webMethods. Within this selection, you can
navigate to: My webMethods Server

For more information, see webMethods Task
Engine User’s Guide.

My Inbox to view tasks assigned to you.

Task List Management tomonitor andmanage
running tasks. Use the task list to suspend,
resume, assign, delegate, and resubmit tasks,
among other activities.

Task Charts to view basic task charts.

[Task Type] to view a custom inbox showing
all of the tasks of this type that are assigned to
you (there is a separate [Task Type] selection
for each type of task assigned to you).

Optimize for ProcessSix Sigma Summary to view six sigma information
for process instances.

For more information, see webMethods
Optimize User’s Guide.

Monitoring: Integration

The following table lists the items, available in the Integration menu and the components that
each item requires.

Required componentsItem

Trading NetworksB2B to monitor Trading Networks transactions
and other data related to exchanging data with

Formore information, seewebMethods Trading
Networks User’s Guide.

trading partners. Also to set Trading
Networks-specific My webMethods preferences.

Transactions to track andmanage documents
that Trading Networks has processed.

Tasks to view the status and details of delivery
and service execution tasks that Trading
Networks createswhen processing documents.
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Required componentsItem

Activity Log to view log entries for activities
occurringwithin the TradingNetworks system.

User Preferences to set Trading
Networks-specific user preferences.

MonitorServices to view log data that an Integration Server
has logged for a service and to resubmit services.

Formore information, seewebMethodsMonitor
User’s Guide.

MonitorDocuments to view and resubmit documents that
have been logged to the logging database.

Formore information, seewebMethodsMonitor
User’s Guide.

Administration Section of the Navigate Tab

The items in the Administration section of the Navigate tab depend on the webMethods
components, available in you installation.

Administration: Messaging

The following table lists the items, available in the Messaging menu and the components that
each item requires.

Required componentsItem

webMethods Broker (deprecated)Broker Servers to manage and monitor
webMethods Broker Servers, webMethods Brokers
(deprecated), document types, client groups, and
clients.

BrokerTerritories to create and manage territory
webMethods Brokers (deprecated) and territory
gateways.

BrokerClusters to create and manage cluster
webMethods Brokers (deprecated) and cluster
gateways.

Naming Directories to create and configure
administered objects used by JMS.

Settings to configure parameters relating to the
operation of the webMethods Broker (deprecated)
user interface on My webMethods
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Required componentsItem

Log to view error and activitymessages generated
by the webMethods Broker (deprecated) user
interface.

Administration: System-Wide

The following table lists the items, available in the System-Wide menu and the components that
each item requires.

Required componentsItem

My webMethods ServerPermissions Management to manage access
privileges and functional privileges that you assign
to users, groups, and/or roles. For more information, see Administering My

webMethods Server.

My webMethods ServerUser Management to manage users, groups, and
roles. Within this selection, you can navigate to:

For more information, see Administering My
webMethods Server.Roles to add, edit, and delete roles.

Groups to add, edit, and delete groups.

User to add, edit, and delete users.

Certificates to manage authentication
certificates.

Task EngineCalendars Management to configure andmanage
calendars. Within this selection you can navigate
to: For more information, see webMethods Task

Engine User’s Guide.
Business Calendars to add, edit, and delete
business calendars.

User Calendars to add, edit, and delete user
calendars.

My webMethods ServerWorkspace Management to manage and
manipulate allworkspaceswithinMywebMethods.

For more information, see Administering My
webMethods Server.

webMethods Broker (deprecated)Environments to configure environments for
Optimize for Process and Optimize for

Optimize for InfrastructureInfrastructure. Within this selection, you can
navigate to: Optimize for Process
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Required componentsItem

My webMethods ServerDatabase Pool Configuration to maintain a
common list of database pools forwebMethods
servers in an environment. For more information, see Configuring BAM.

Define Environments to define environments
and common configurations for Optimize for
Process and Optimize for Infrastructure
components.

Optimize for InfrastructureSystem Information to:

Optimize for ProcessSet up logging, and view information about the
Analytic Engines,Web ServiceData Collectors,
and Prediction Engine. For more information, see Administering

webMethods Optimize and Configuring BAM.
View information for common configuration
environments. You can view the operational
status and component ID, host and port
information for a components in your
webMethods environments.

Trading NetworksB2B Permissions to manage permissions that
control access to Trading Networks data and
actions. Within this selection, you can navigate to: Formore information, seewebMethods Trading

Networks Administrator’s Guide.
Data Permissions to identify data sets and
indicate the actions roles can take against
Trading Networks data in the data sets.

General Functional Permissions to indicate
the Trading Networks actions that roles can
perform. These permissions govern Trading
Networks data not covered by data
permissions.

Administration: Analytics

The following table lists the items, available in the Analytics menu and the components that each
item requires.

Required componentsItem

Optimize for InfrastructureRules to manage KPI, event, and threshold rules.
Within this selection, you can navigate to:

Optimize for Process
Rule List to create rules to notify you when a
process or resource becomes problematic and
requires user attention.

For more information, see webMethods
Optimize User’s Guide.
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Required componentsItem

Rule Filters to edit data collection filters.

Rule Audit to view complete auditing details
for every rule-related change in your system.

Optimize for InfrastructureKPIs to configure Key Performance Indicators
(KPIs). Within this selection, you can navigate to:

Optimize for Process
Business Data to configure KPIs for business
data. For more information, see Administering

webMethods Optimize.
System Data to configureKPIs for systemdata.

Dimensions to define dimensions.

KPI Hierarchies to view a graphical hierarchy
of your system components to help you
understand the hierarchy and interdependency
of these components.

Intelligent Links to configure dynamic links
to Web pages inside or outside of My
webMethods and display those links on
appropriate pages.

Optimize for InfrastructureData Management to extract Optimize assets and
purge data from theOptimizeAnalysis andProcess

Optimize for ProcessTracker database components.Within this selection,
you can navigate to: For more information, see Administering

webMethods Optimize.Asset Extraction to extract various Optimize
assets (such as dimensions and event maps),
save them to your file system, and later deploy
them to another Optimize Analytic Engine.

Live Purge to purge data from the Optimize
Analysis and Process Tracker database
components.

Optimize for InfrastructureInfrastructure Components to configure
components of the system, such as Integration
Servers, that are automatically monitored. Optimize for Process

For more information, see Administering
webMethods Optimize.

Optimize for ProcessPrediction to create prediction templates.

For more information, see webMethods
Optimize User’s Guide.
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Required componentsItem

Optimize for InfrastructureDiagnostics to view information to troubleshoot
issues with event maps, dimensions, hierarchies,
KPIs, and rules. Optimize for Process

For more information, see webMethods
Optimize User’s Guide.

Optimize for InfrastructureJob Management to view activities of the Job
Manager, which coordinates system activities.

Optimize for Process
Job Audit to view summary information about
all jobs scheduled with the Job Manager. For more information, see Administering

webMethods Optimize.
Job Queue to view the status of all jobs
scheduled with the Job Manager.

Administration: Business

The following table lists the items, available in the Business menu and the components that each
item requires.

Required componentsItem

webMethods Rules DevelopmentwebMethodsBusiness Rules to dynamically
update business rules created with the Rules
Development feature in Software AG Designer. For more information, see webMethods BPM

Rules Development Help.

MonitorBusiness Processes to access andmodifydetailed
process model information, and to identify the

Optimize for Processprocess models that you want to monitor using
Monitor and Optimize for Process. Formore information, seewebMethodsMonitor

User’s Guide or Administering webMethods
Optimize.

MonitorBusiness Processes Dashboard to quickly access
andmodify key information about a processmodel.

Formore information, seewebMethodsMonitor
User’s Guide.

For example, is it enabled, how many instances
exist, or how many are running and failed? Click
a process link to open an editable dialog box with
key processmodel attributes.Hover the cursor over
the process name to view a pop-up process
diagram.

MonitorData Management to archive and delete logging
data from the Process Audit database and to view
archive history. Formore information, seewebMethodsMonitor

User’s Guide.
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Required componentsItem

Task EngineTasks to administer tasks that have been published
to My webMethods Server. From here you can:

For more information, see webMethods Task
Engine User’s Guide.Enable disable, delete, and start tasks.

Configure collaboration tasks.

Configure a task analytics connection.

Configure a task e-mail listener connection.

Administration: Integration

The following table lists the items, available in the Integration menu and the components that
each item requires.

Required componentsItem

Trading NetworksB2B to manage Trading Networks partner
management, manage the archival and deletion of

Optimize for B2BTrading Networks data, and configure Business
Activity Monitoring for Trading Networks data. Formore information, seewebMethods Trading

NetworksAdministrator’sGuide andwebMethods
Optimize for B2B User’s Guide.

Archive Schedules to configure and schedule
the archival and deletion of Trading Networks
data.

Partner Profiles to add, edit, and delete
TradingNetworks profiles and extendedprofile
fields.

Partner Groups to add, edit, and delete
Trading Networks partner groups.

Partner Certificates to query for partner
certificates that are expired or expiring soon.

Public Queues to add, edit, and delete Trading
Networks public queues.

Business Monitoring to configure TN
document types for BAM (Business Activity
Monitoring) and globally enable all the TN
document types for monitoring.

Trading NetworksB2B Settings to set configuration settings for
Trading Networks, Module for EDI, and Module
for EDIINT. Module for EDI
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Required componentsItem

Module for EDIINTAdministrative Preferences to set
administrative settings, including identifying

Formore information, seewebMethods Trading
Networks Administrator’s Guide, webMethods

the Trading Networks server that My
webMethods Server is to interact with.

Module for EDI Installation and User’s Guide ,
andwebMethodsModule for EDIINT Installation
and User’s Guide

Configure Properties to set the configuration
properties of Trading Networks, Module for
EDI, and Module for EDIINT.

Submit Documents to submit XML or EDI
documents to Trading Networks.

Control Numbers to search, create, and
manage control numbers in Module for EDI.

Integration ServerESB to access Integration Server Administrator so
that you can administer Integration Servers.

For more information, see webMethods
Integration Server Administrator’s Guide.

Administration: My webMethods

The following table lists the items, available in the My webMethods menu and the components
that each item requires.

Required componentsItem

MonitorSystem Settings to change the host names and
port numbers that My webMethods uses to

Optimize for Infrastructurecommunicate with the Integration Server, the
Analytic Engine, and the Task Engine. Optimize for Process

Task Engine

Formore information, seewebMethodsMonitor
User’s Guide, Administering webMethods
Optimize, and webMethods Task Engine User’s
Guide.

My webMethods ServerDirectory Services to configure external directory
services you want to use with My webMethods.

For more information, see Administering My
webMethods Server.

My webMethods ServerE-mail Servers to configure themail server settings
used by My webMethods Server when processing
e-mail messages. For more information, see Administering My

webMethods Server.
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Required componentsItem

My webMethods ServerCluster Settings to define theURL to use to access
My webMethods in a clustered environment and

For more information, see Administering My
webMethods Server.

to configure different roles of My webMethods
Server clustered nodes.

My webMethods ServerData Sources to connect to external data sources,
such as databases, and make them available to My
webMethods Server. For more information, see Administering My

webMethods Server.

Workspace Selections in the Navigate Tab

The Workspaces section of the Navigate tab provides access to workspaces. It has two sections:

Recently Added that lists workspaces that you have recently added and saved.

My Workspaces that lists workspaces that you have added to your navigation. These can be
either workspaces that you have created or workspaces that another user has created and
shared with you. For more information, see “About Adding Workspaces to the Navigation
Pane” on page 60.

Tool Selections in the Tools Tab

The selections listed in the Tools tab might differ based on the permissions you are assigned.

To use a tool, you drag it onto a workspace. In response, My webMethods adds a portlet window
to the workspace for the tool. For more information about using tools in workspaces, see “Using
Tools to Enhance Workspaces” on page 73 and Diagnosing My webMethods Server.

Layout Section of the Tools Tab
The tools for layout management in a typical My webMethods installation are located on the
Layout section of theTools tab. The section includes theRow tool, which adds rows to aworkspace.

For more information about the Row tool, see Administering My webMethods Server.

MWS Monitoring and Diagnostics Section of the Tools Tab
The tools for monitoring and diagnosing that a typical My webMethods installation provides are
located in the MWS Monitoring and Diagnostics section of the tab.

MWS Monitoring and Diagnostics: Log Tracing and Analysis

The following table lists the items, available in the Log Tracing and Analysis menu and the
components that each item requires.
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Required componentsItem

My webMethods ServerLog Analysis Datasource to read and analyze log
files created within My webMethods Server.

For more information, see Diagnosing My
webMethods Server.

My webMethods ServerLog Analysis Time Period to configure a time
period for creating log fileswithinMywebMethods
Server. For more information, see Diagnosing My

webMethods Server.

My webMethods ServerLog Configuration to set the logmessage collection
criteria.

For more information, see Diagnosing My
webMethods Server.

My webMethods ServerLog Errors by Severity to analyze and display
logs of WARNING, ERROR, or FATAL severity.

For more information, see Diagnosing My
webMethods Server.

My webMethods ServerLog FATAL Issues to analyze and display logs
only of FATAL severity.

For more information, see Diagnosing My
webMethods Server.

My webMethods ServerLog Issues to analyze and display logs of
WARNING, ERROR, or FATAL severity.

For more information, see Diagnosing My
webMethods Server.

My webMethods ServerLog Issues by Component to analyze anddisplay
logs by the component in which they appear.

For more information, see Diagnosing My
webMethods Server.

My webMethods ServerLog Issues by Product to analyze and display
logs by the product in which they appear.

For more information, see Diagnosing My
webMethods Server.

My webMethods ServerLog Viewer to view the latest messages in plain
text log files of My webMethods Server.

For more information, see Diagnosing My
webMethods Server.

My webMethods ServerMost Used Portlets to display statistics about the
ten most used portlets in My webMethods Server.

For more information, see Diagnosing My
webMethods Server.
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Required componentsItem

My webMethods ServerMost Used Web Services to display statistics
about the ten most used Web services in My
webMethods Server. For more information, see Diagnosing My

webMethods Server.

My webMethods ServerSOAP Traffic Monitor to debug issues with web
service calls from other portlets.

For more information, seeMy webMethods
Server Portlet Reference.

MWS Monitoring and Diagnostics: Performance Information

The following table lists the items, available in the Performance Information menu and the
components that each item requires.

Required componentsItem

My webMethods ServerPerformance Analysis to measure and analyze
the performance ofMywebMethods Server services
and custom portlets or applications. For more information, see Diagnosing My

webMethods Server.

My webMethods ServerPerformance Statistics to display statistic and
analysis information about the performance of

For more information, see Diagnosing My
webMethods Server.

various My webMethods Server actions which are
grouped by categories.

My webMethods ServerSlow Database Calls to display information about
ten of the slowest database calls inMywebMethods
Server. For more information, see Diagnosing My

webMethods Server.

My webMethods ServerSlow Portlets to display performance information
about ten of the slowest portlets inMywebMethods
Server. For more information, see Diagnosing My

webMethods Server.

My webMethods ServerSlow Web Services to display performance
information about ten of the slowest Web services
in My webMethods Server. For more information, see Diagnosing My

webMethods Server.

MWS Monitoring and Diagnostics: System Information

The following table lists the items, available in theSystem Informationmenu and the components
that each item requires.
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Required componentsItem

My webMethods ServerMemory Monitor to monitor the memory usage of
the Java Virtual Machine (JVM) and send

For more information, seeMy webMethods
Server Portlet Reference.

notifications to administrators when configured
threshold limits are reached.

My webMethods ServerOverview to view server information on the
following tabs:

System Properties

Request Properties

Session Attributes

Application Attributes

My webMethods ServerThread Dump to monitor thread execution
deadlocks in My webMethods Server threads.

For more information, see Diagnosing My
webMethods Server.

My webMethods ServerWorkspace Context Viewer to view, add, modify,
and delete context information about the currently
displayed workspace page.

Workspace Tools Section of the Tools Tab
The tools for workspace management that My webMethods provides as installed are in the
Workspace Tools section of the tab.

The following table describes the workspace tools, available on the Tools tab.

DescriptionTool

Attaches files to a workspace. For more information, see “Attachments
Tool” on page 76.

Attachments

Adds a list of links to external web sites and links to other workspaces. For
more information, see “Bookmarks Tool” on page 79.

Bookmarks

Adds a search window to a workspace that allows you to find identification
information about other My webMethods users. For more information, see
“Directory Browser Tool” on page 82.

Directory Browser

Adds formatted text to a workspace. For more information, see “HTML Text
Tool” on page 83.

HTML Text

Adds an image to a workspace. For more information, see “Image Tool” on
page 84.

Image
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DescriptionTool

Adds a simple note to aworkspace. Formore information, see “Note Tool” on
page 86.

Note

Adds a user’s calendar to a workspace so that you can view the user’s
availability. For more information, see “User Calendar Tool” on page 88.

User Calendar

Note:
Your installationmight includemore tools, added by aMywebMethods developer. Check with
your system administrator or developer for information about site-specific tools.

Format of Application Pages

The following screenshot shows the format of a typical application page.

The following table describes the elements of an application page.

My webMethods displays the title of the application page at the top.Title of the
page

If you have navigated to a subpage within a selection from the navigation pane,
My webMethods displays the title of the selection from the navigation pane along
with the title of the current page, using the formatMain Page > Subpage.

The format of the page content is determined by the webMethods component that
displays the page. Many pages uses similar panels for searching for:

Page content

Users/groups/roles, formore information see “Searching for Users, Groups, and
Roles” on page 91.

Data, for more information see “Searching for Data” on page 95
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Format of Workspace Pages

The following screenshot shows the format of a workspace page.

The following table describes the elements of a workspace page.

If you have unsaved changes in a workspace, My webMethods displays an
asterisk (*) before the workspace name on the tab.

Unsaved changes
indicator

My webMethods displays the name of the workspace at the top.Title of the
workspace

The owner of the workspace and contributors to the workspace determine the
content of the workspace. You can add windows from application pages,

Page content

windows from other workspaces, and add tools to the workspace. For more
information, see “Working with My webMethods Workspaces” on page 49
and “Working with Workspace Content” on page 63.
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The My webMethods Profile

The system maintains a profile for each user of My webMethods. You access your profile via the
My Profile standard link. The following table lists the settings you can update from your profile,
and where to find more information about these settings:

Additional informationSetting

“Changing Your Password” on page 11My webMethods password

“Identifying Yourself to My webMethods” on
page 38

Identity and locale

“Setting Your User Preferences” on page 41Page to display at login

“Defining the Number of Search Results Rows
to Display Per Page” on page 105

Number of search results to display

“Setting Your User Preferences” on page 41Whether todisplay confirmationmessages before
completing actions, such as before deleting a
workspace

“Calendars” on page 45Business and user calendar

Identifying Yourself to My webMethods

Your identification information is listed on the User Information and User Profile tabs of your
profile.

User Information tab. Your name and e-mail address are on the User Information tab.

Note:
You can only update the fields on the User Information tab if your user account is defined
in My webMethods, that is, the “System” directory service. If your user account is defined
in an external directory management system, for example LDAP, My webMethods obtains
values from the external directory management system for these fields.

User Profile tab. Several fields that provide optional information that you can supply about
your identity.

To identify yourself to My webMethods

1. Click the My Profile link, which is located at the top of all My webMethods pages.

2. Click the User Information tab.

a. Use the First Name and Last Name fields to specify your name.
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b. Optionally, type your e-mail address in the E-mail Address field.

Note:
MywebMethodswill not be able to send you notifications if you do not specify an e-mail
address. For example, if your system administrator enables GDPR (General Data
Protection Regulation) notifications, you cannot receive notifications about updates to
your profile data if you do not specify an e-mail address.

3. Click the User Profile tab.

4. Enter optional information for your profile in the input fields.

The following table lists the optional information that you can add to your profile.

DescriptionField

Your middle name.Middle Name

Your title, for example, Mr., Mrs., or Ms. If the title youwant to use does
not appear in the list, select Other. My webMethods prompts you for
the title you want to use.

Title

The suffix that should appear after your name, if any, for example, Jr.,
Sr., PhD, III. If the suffix you want to use does not appear in the list,

Name Suffix

select Other. My webMethods prompts you for the suffix you want to
use.

Your language and locale. The Default selection indicates you want to
use the language installed on My webMethods Server.

Preferred
Language/Locale

The country where you are located.Country/Region ID

Your street address.Address 1

Address 2

The city where you are located.City

The state or province where you are located.State/Province

Your postal code, for example, a ZIPCode if you are located in theUnited
States.

Postal Code

The country where you are located.Country/Region ID

Your area code.Phone 1 Area Code

Your phone number.Phone 1 Number

Your extension, if any.Phone 1 Extension
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DescriptionField

The country code associated with your phone number.Phone 1 Country
Code

The date format you want My webMethods to use when displaying
dates. For more information about date formats, see the
SimpleDateFormat class in the Oracle Java API documentation.

Default Date
Format

The time format you want My webMethods to use when displaying
times. For more information about date formats, see the
SimpleDateFormat class in the Oracle Java API documentation.

Default Time
Format

The time zone that My webMethods uses when displaying times.Default Time Zone

Important:
Changing the time zone in the Default Time Zone field may result
in the loss of transactional context, such as search results, sorting, and
details, when you return to the page you were previously using. For
more information about how to change the time zone without any
impact on transactional context, see “Configuring the Time Zone in
My webMethods ” on page 47.

The format that My webMethods uses when displaying numbers. For
more information about number formats, see the DecimalDateFormat
class in the Oracle Java API documentation.

Default Number
Format

The format that My webMethods uses when displaying currency. For
more information about currency formats, see the DecimalDateFormat
class in the Oracle Java API documentation.

Default Currency
Format

Note:
Not all portlets make use of the defaults that you specify in Default Date Format, Default
Time Format,Default Time Zone,Default Number Format, andDefault Currency Format.

5. Optionally, review the information about the date and time of creation and last modification
of your profile in the Created Date and Last Modified Date fields.

6. Click Save.

7. If you are done updating your profile, close the My Profile tab. For instructions, see “Closing
Tabs” on page 17.

Exporting Your My webMethods Profile Data

You can export a .json file with the user data from your profile from the My Profile page in My
webMethods.
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To export your profile data:

1. In My webMethods, click My Profile.

2. On the User Profile tab of the Profile Attributes section, click Export User Data.

My webMethods exports your profile data in a .json file.

Generating a Shared Secret for Multi-Factor Authentication

When your organization enablesmulti-factor authentication forMywebMethodswith a time-based
one-time password, you must generate a shared secret for your user profile and register it with
the one-time password service or authenticator application.

To generate a shared secret:

1. In My webMethods, click My Profile.

2. On the User Profile tab of the User Attributes section, click Generate Shared Secret.

My webMethods sends an e-mail with the shared secret to the e-mail address configured for
your user profile. For information about how to register the shared secret with the password
provider service or application, see the instructions provided by your organization or the
authenticator documentation.

Deleting Your My webMethods Profile

You can delete your own profile from the My Profile page in My webMethods. For this option to
be available, your system administratormust enable and configureGDPR (General Data Protection
Regulation) settings. If your profile is defined in an external location, you might still be able to
log on to My webMethods after deleting it. Contact your system administrator to completely
remove your logon information from My webMethods.

To delete your profile:

1. In My webMethods, click My Profile.

2. On the User Profile tab of the Profile Attributes section, click Delete User Profile.

3. Click OK.

Setting Your User Preferences

The User Preferences tab contains miscellaneous My webMethods preferences that you can set
for your interaction with My webMethods. This section describes how to set the preferences that
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My webMethods provides as installed. For more information about these preferences, see “My
webMethods User Preferences” on page 43. The My webMethods administrator can remove
preferences and/or add additional preferences. As a result, your preferences might be different.

To set your user preferences

1. Click the My Profile link, which is located at the top of all My webMethods pages.

2. Click the User Preferences tab.

3. To identify the application page, workspace, or tab that you want My webMethods to display
when you log into My webMethods, do one of the following:

To identify an application page that you want My webMethods to display:

1. In the Start Page field, click Application Page.

2. Navigate to the page you want displayed by clicking the links in the Name column.

3. When the page you want displayed is in the list, select it.

4. Click Apply.

5. Click Save.

To identify a workspace that you want My webMethods to display:

1. In the Start Page field, click Workspace.

2. Use the search fields to search for the workspace that you want displayed and click
Search.

3. In the results, select the workspace that you want displayed.

4. Click OK.

5. Click Save.

To indicate that you want My webMethods to display the last active tab from your last
session at login:

1. In the Start Page field, click Clear.

2. Select the Open Last Active Tab on Login check box.

3. Click Save.

4. To indicate whether you want My webMethods to prompt you to confirm actions, perform
the following steps:
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a. If you want My webMethods to prompt you to confirm the deletion of a workspace, select
the Show Delete Workspace Confirmation check box. If you want My webMethods to
immediately delete a workspace with no confirmation, clear the check box.

b. If you want My webMethods to prompt you to confirm the deletion of a window from a
workspace, select the Show Delete Window Confirmation check box. If you want My
webMethods to immediately delete a window with no confirmation, clear the check box.

c. If you want My webMethods to prompt you to confirm a request to close all tabs except
the current one, select the Close All Tabs Confirmation check box. If you want My
webMethods to immediately close tabs with no confirmation, clear the check box.

d. Click Save.

5. To identify the default number of rows that you want MywebMethods to display in windows
that list items in rows, for example, in search results, select one of the following in the Items
Per Page field and click Save.

Default to allow My webMethods to determine the number of items to display per page.

A number to indicate the number of items you want MywebMethods to display per page.

Show All to have My webMethods display all items on a single page.

6. If you want My webMethods to automatically save changes to a workspace when you select
to view another workspace or application page, select the Auto-Save when Navigating to a
Different Workspace check box. If you want My webMethods to prompt you to save changes
before displaying another workspace or application page, clear the check box.

7. If youwantMywebMethods to perform full-page refreshes rather than asynchronous refreshes,
select the Bypass Full Page Refreshes When Possible check box.

8. If you are done updating your profile, close the My Profile tab. For instructions, see “Closing
Tabs” on page 17.

My webMethods User Preferences
You set specific preferences for your user profile as described in “Setting YourUser Preferences” on
page 41.

The following table lists the preferences, available in a typical My webMethods installation.

DescriptionPreference

Indicates the application page or workspace that you want My
webMethods to display when you initially log into My

Start Page
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DescriptionPreference

webMethods. This setting overrides the Open Last Active Tab
on Login preference.

IfStart Page is set, at loginMywebMethods displays the page
identified by the Start Page preference. This preference takes
precedence over the Open Last Active Tab on Login
preference.

If Start Page is not set, but Open Last Active Tab on Login
is set, at login My webMethods displays the last active tab
from your last session.

If neither theStart Page norOpen Last Active Tab on Login
are set, at login My webMethods displays a blank workspace
in a new tab.

Identifies whether you want My webMethods to display the last
active tab from your last session at login. The Start Page

Open Last Active Tab on
Login

preference overrides this preference. For more information about
how the two preferences work together, see the description of the
Start Page preference.

Indicates the default number of rows that My webMethods
displays, for example, in search results.

Items Per Page

When you delete a workspace, this preference indicates whether
you want My webMethods to prompt you to confirm the action.

Show Delete Workspace
Confirmation

When this check box is cleared and you delete a workspace, My
webMethods immediately deletes the workspace without asking
for confirmation.

When you delete a window from a workspace, this preference
indicates whether you want My webMethods to prompt you to

Show Delete Window
Confirmation

confirm the action. When this check box is cleared and you delete
awindow fromaworkspace,MywebMethods immediatelydeletes
the window without asking for confirmation.

When you request that My webMethods close all tabs except the
current one, this preference indicates whether you want My

Show Close All Tabs
Confirmation

webMethods to prompt you to confirm the action.When this check
box is cleared and you request to close all tabs, My webMethods
immediately closes the tabs without asking for confirmation.

When you are viewing a workspace that has changes that have
not yet been saved and click a tab to view another workspace or

Auto-Save when Navigating
to a Different Workspace

application page, the preference indicates whether you want My
webMethods to automatically save the changes to the current
workspace before displaying the selectedworkspace or application
page. When this check box is cleared, My webMethods prompts
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DescriptionPreference

you to ask if you want the changes saved before displaying the
selected workspace or application page.

When you make a change to a page and apply the changes, My
webMethods asynchronously refreshes only the portion of the

Bypass Full Page Refreshes
when possible

page that you have modified. When this check box is cleared, My
webMethods refreshes the full page.

Calendars

The My webMethods profile contains calendar information that the Task Engine uses to assist
with task definition and behavior.

The two types of calendars are business calendars and user calendars.

Business calendars define standard business days and hours for your organization, including
holidays, weekends, and other times when your organization is not conducting business. An
administrator configures the business calendars. For example, an administratormight configure
a business calendar for normal business hours of Monday through Friday, 8:00 A.M. to 5:00
P.M. Eastern Standard time.

An administrator can configuremultiple business calendars. For example, if your organization
has different shifts, an administrator can configure a business calendar for each shift. Another
reason formultiple business calendarsmight be if your organization spansmultiple time zones;
an administrator can configure a business calendar for each time zone.

If an administrator has configured business calendars, in your My webMethods profile, you
can select the business calendar that best fits your working hours so that the Task Engine can
determine your business hours and schedule tasks accordingly. For instructions, see “Defining
Your Business Calendar” on page 46.

User calendars are calendars that a third-party applicationmaintains, for example, aMicrosoft
Outlook calendar or Lotus Notes calendar. An administrator must configure the My
webMethods Server so that it can access the user calendars. You maintain your calendar in
the third-party application to define your availability. As a result, the Task Engine can determine
your individual availability when scheduling tasks. Also, you can view a read-only version
of your calendar within My webMethods. For instructions, see “Viewing Your Personal User
Calendar” on page 46.l

Note:
If an administrator configures the use of user calendars, you can also use the User Calendar
tool in aworkspace to display your availability or the availability of anotherMywebMethods
user by adding a user calendar to a workspace. For more information, see “User Calendar
Tool” on page 88.
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Defining Your Business Calendar

On the Calendar tab of your profile, you can define the business calendar to use for your user
account. By default, My webMethods uses the default calendar that the administrator creates.

Note:
You can only select a business calendar for your user account if an administrator has previously
configured business calendars.

To define your business calendar

1. Click the My Profile link, which is located at the top of all My webMethods pages.

2. Click the Calendar tab.

3. In the User Business Calendar panel, in the Business Calendar list, select the calendar to
use for your user account.

4. Click Save.

Viewing Your Personal User Calendar

On the Calendar tab of your profile, you can view your user calendar, which shows your
availability. The user calendar displays the calendar that youmaintain in a third-party application,
such as Microsoft Outlook or Lotus Notes.

Note:
You can only view your personal user calendar if an administrator has previously configured
My webMethods Server to access user calendars from a third-party application.

To view your user calendar

1. Click the My Profile link, which is located at the top of all My webMethods pages.

2. Click the Calendar tab.

My webMethods displays your user calendar in the User Personal Calendar panel. If an
administrator has not configuredMywebMethods Server to access user calendars,MywebMethods
displays a message indicating that user calendars are not available.
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Changing the Time Zone in My webMethods

By default,MywebMethods Server displays times in your local time zone based on browser locale.
Although you can change the time zone from the default one in your profile in My webMethods,
doing somay result in the loss of transactional context, such as search results, sorting, and details,
when you return to the page you were previously using.

Use the following procedure to change the time zone on any page in My webMethods without
losing transactional context.

To change the time zone in My webMethods

1. On any page in My webMethods, in the bottom left corner of the page, click the time zone
link next to All times.

2. In theTimezone field of the Select Timezone dialog box, select a time zone from the drop-down
list.

3. Click Apply.

The My webMethods page refreshes automatically showing the existing data, but any times on
the page are updated to reflect the new time zone. For example, if you search for tasks in your
inbox and then you change the time zone on the My Inbox page, the dates associated with the
tasks are updated to reflect the new time zone.

48 Working with My webMethods 10.11

4 Configuring the Time Zone in My webMethods



5 Working with My webMethods Workspaces

■   About Workspaces ......................................................................................................... 50

■   About Creating New Workspaces ................................................................................... 50

■   Defining the Layout of a Workspace ............................................................................... 51

■   Opening Workspaces ..................................................................................................... 53

■   Workspace Properties .................................................................................................... 53

■   Setting General Properties for a Workspace .................................................................. 54

■   Renaming Workspaces .................................................................................................. 55

■   Workspace Sharing ........................................................................................................ 55

■   Closing Workspaces ....................................................................................................... 59

■   Deleting Workspaces ...................................................................................................... 59

■   About Adding Workspaces to the Navigation Pane ........................................................ 60

Working with My webMethods 10.11 49



About Workspaces

A workspace is a page where you add the content that you want. You can add:

Tools that My webMethods provides, for example, the Attachments tool that allows you to
attach files to a workspace. For more information about tools that My webMethods provides,
see “Using Tools to Enhance Workspaces” on page 73.

Custom tools that a developer at your site has created and added to My webMethods.

Windows from application pages. As youwork withMywebMethods, you navigate through
the user interface to display information that you need or that you are interested in. My
webMethods displays the information in the user interface using portlet windows. When you
encounter information that is vital for you or that you frequently use, you can add it to a
workspace. The windows that you addmaintain their context when the system displays them
in a workspace. For example, if you select to add a monitor that is displaying order cycle time
to aworkspace,when you view theworkspace, thewindowwill display themonitor specifically
for order cycle.

Windows from other workspaces. If you are viewing a workspace and want a copy of a
window that is in one workspace in another workspace, you can copy it.

For more information about managing the content in a workspace, see “Working withWorkspace
Content” on page 63.

You can create as many workspaces as you need. You can share your workspaces with other users
or use workspaces that other users have shared with you.When a workspace is shared, the owner
sets the permissions that define the actions users can take against the workspace. For example,
youmight share one of yourWorkspaces and only allow users to view the content, but not modify
it. For more information about sharing workspaces, see “Workspace Sharing” on page 55.

Use workspaces to group related information. Examples of uses for workspaces might be to:

Group information and tools that you frequently use in one location. For example, youmight
be involved with several projects and want to create a separate workspace for each project.

Troubleshoot an issue. You can add information related to the issue to a workspace. You
might want to share the workspace with other users that are involved in the issue. You can
add tools, such as the Discussion Topics tool, to facilitate discussions about the issue with
other users.

Organize the work you need to do for tasks. For example, in My webMethods you might
display your task inbox and search for specific tasks. You can add the search results to a
workspace. Then you can add additional tools or windows from application pages that you
need to accomplish the tasks.

About Creating New Workspaces

When creating a new workspace, you can either create:

An empty workspace
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A workspace that is a copy of an existing workspace

To copy an existing workspace, you use “save as” functionality to save an existing workspace
using a newname. As youmake changes to the new and originalworkspaces,MywebMethods
does not synchronize the changes. The two workspaces are distinct.

Creating New Empty Workspaces

To create new empty workspaces

1. Click the New tab, which My webMethods always displays as the last visible tab above the
content area.

My webMethods displays an empty workspace with a default name. To change the name, see
“Renaming Workspaces” on page 55.

2. Click on the tab for the new workspace and select Save Workspace.

Using “Save As” to Create a New Workspace

To create a new workspace that is a copy of an existing workspace

1. Open the workspace that you want to use as the base for the newworkspace. For instructions,
see “Opening Workspaces” on page 53.

2. Click on the tab for the workspace and select Save As.

3. In the Save Workspace As window in the New Workspace Name field, type the name you
want to use for the new workspace.

4. Click OK.

Defining the Layout of a Workspace

To define how the windows within a workspace can be positioned, define the workspace layout.
There are two types of layouts:

Column layout. In this layout, all thewindows in aworkspace are aligned in columns.Windows
cannot overlap within a column. You can define a workspace to have one, two, three, or four
columns.

Free Form layout. In this layout, you can place windows on the workspace in any location.
Windows can overlap and even completely cover one another. This is the default for a new
workspace.

For instructions for adding windows to a workspace, see:
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“Adding Tools to a Workspace” on page 64

“Adding Windows from Application Pages to a Workspace” on page 64

“Adding Windows from a Workspace to Another Workspace” on page 66

For instructions for how to position windows within a workspace, see “Positioning Windows in
a Workspace” on page 71.

Note:
To define or update the layout for a workspace you must either be the owner of the workspace,
or if you are using a workspace that another user has shared with you, you must have “View
and Modify” or “Full Control” permissions to the workspace. If you have “View Only”
permission to a workspace, you can change the layout; however, you cannot save the changes;
as a result, when you leave theworkspace, it will revert to its previous state. Formore information
about sharing workspaces, see “Sharing Workspaces” on page 58.

To define the layout of a workspace

1. Click on the tab for the workspace and select Workspace Properties.

2. Select the Layout tab.

3. From the Columns list, select layout that you want to use for the workspace.

4. If you select One Column, Two Columns, Three Columns or Four Columns, you can set
additional properties for each column in the layout.

a. In the Width field type the percentage of the workspace to use for the column. By default
the percentages are set for evenly spaced columns.

b. Select the Word Wrap check box if you want My webMethods attempt to wrap long text
lines within windows in the workspace to fit the window size. Clear the check box if you
do not want long lines to wrap.

Allowing long lines to wrap helps to better fit windows within columns.

c. From theHorizontal Alignment list select how thewindows should be aligned horizontally
in the column. By default, My webMethods left aligns the windows in each column.

d. From the Vertical Alignment list select how the windows should be aligned vertically in
the column. By default, My webMethods aligns the windows at the top of each column.

5. Click OK.

6. Click on the tab for the workspace and select Save Workspace to save your changes.

52 Working with My webMethods 10.11

5 Working with My webMethods Workspaces



Opening Workspaces

You can open workspaces that you own and workspaces that other users own and have shared
with you. For more information about shared workspaces, see “SharingWorkspaces” on page 58.

To open a workspace

1. In the navigation pane, click the Navigate tab.

2. In theWorkspaces section of theNavigate tab, browse to and click the name of theworkspace
you want to open.

Note:
If the workspace youwant to open is not in the navigation pane, you can search for and add
it to the navigation. Formore information, see “AboutAddingWorkspaces to theNavigation
Pane” on page 60.

Workspace Properties

You can open the properties of a workspace to view or set them. The properties are grouped on
the following tabs:

General tab, which lists properties, such as the workspace name and description. For a list
and description of each general property, see the table below.

Layout tab, which you can use to define how windows can be positioned in a workspace. For
more information, see “Defining the Layout of a Workspace” on page 51.

The following table describes the properties on the General tab.

DescriptionPropertySection

The name of the workspace.NameGeneral

For instructions for changing the workspace name, see
“SettingGeneral Properties for aWorkspace” on page 54 and
“Renaming Workspaces” on page 55.

A description for the workspace.Description

Note:
Currently the description is only listed in the properties
and is not used by My webMethods for any specific
purpose.

For instructions for changing the workspace description, see
“Setting General Properties for a Workspace” on page 54.
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DescriptionPropertySection

Keywords that you assign to a workspace that you can later
use when searching for a workspace.

Keywords

For instructions for defining keywords for a workspace, see
“Setting General Properties for a Workspace” on page 54.

The user name of the user that owns the workspace.OwnerMaintenance

The date and time the workspace was created.Created On

The date and time of the last time theworkspacewas updated.Modified On

This property is intended for expert users. A workspace can
have zero, one, ormore aliases. An alias defines an alternative

Aliases

way to access a workspace. Workspace developers might
need to add aliases if they are building complex multi-page
applications and need to refer to workspaces, for example,
when creating navigation fromone page to another and need
to pass parameters to a specific workspace. For more
information about aliases, see Administering My webMethods
Server.

Setting General Properties for a Workspace

Use the following procedure to view and/or set the general properties for a workspace. For a
description of the properties on the General tab, see “Workspace Properties” on page 53.

Note:
For instructions for setting properties on the Layout tab, see “Defining the Layout of a
Workspace” on page 51.

Note:
To update workspace properties you must either be the owner of the workspace, or if you are
using a workspace that another user has shared with you, you must have “View and Modify”
or “Full Control” permissions to theworkspace. Formore information about sharingworkspaces,
see “Sharing Workspaces” on page 58.

To set the workspace properties

1. Click on the tab for the workspace and select Workspace Properties.

2. Select the General tab.

3. To change the name of the workspace, type a new name in the Name field.
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You can specify from 1 through 255 characters for the name. You can use any characters,
including non-ASCIIs or special characters. The name must be unique among all your
workspaces. If you attempt to assign a duplicate name, My webMethods appends a suffix to
the name, for example, “(2)” to make it unique.

4. Optionally, in the Description field, type a description for the workspace.

You can specify from 1 through 255 characters for the description. You can use any characters,
including non-ASCIIs or special characters.

5. Optionally, in theKeywords field, type one ormore keywords to associatewith theworkspace.
To specify more than one, separate the keywords with a comma.

You can use any characters, including non-ASCIIs or special characters when specifying
keywords. There is no limit to the number of characters you can use in a keyword.

6. Click OK.

7. Click on the tab for the workspace and select Save Workspace to save your changes.

For instructions for working with workspace aliases, see Administering My webMethods Server.

Renaming Workspaces

To rename a workspace you must either be the owner of the workspace, or if you are using a
workspace that another user has shared with you, you must have “View and Modify” or “Full
Control” permissions to the workspace. For more information about sharing workspaces, see
“Sharing Workspaces” on page 58.

To rename a workspace

1. Click on the tab for the workspace and select Rename Workspace.

2. In the RenameWorkspace window in the New Workspace Name field, type a name to assign
to the workspace.

You can specify from 1 through 255 characters for the name. You can use any characters,
including non-ASCIIs or special characters. The name must be unique among all your
workspaces. If you attempt to assign a duplicate name, My webMethods appends a suffix to
the name, for example, “(2)” to make it unique.

3. Click OK to close the Rename Workspace window.

Workspace Sharing

You can share workspaces with other users.
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If you have a workspace that contains information that other users might need to view, share
the workspace with those users and grant them “View Only” permissions to the workspace.

If you have a workspace that other users might want to view, but also can contribute
information, share the workspace with those users and grant them “View and Modify”
permissions.

If you have aworkspace andwant to allow other users to have full control over theworkspace,
share the workspace and grant “Full Control” permissions.

You can share aworkspacewith individual users, groups of users, or roles. If you grant permission
to a group or role, there might be individual users within that group or role that you do not want
to have access to your workspace. In this case, you can explicitly deny a user access.

You can have My webMethods send notification to users when you share or stop sharing
workspaces with them by simply selecting an option when performing the procedure to share or
unshare a workspace. My webMethods does not send notification when you change a permission
for an existing user/group/role, only when a user/group/role is added or removed. For the
notification My webMethods sends an e-mail message.

For a user, MywebMethods obtains the e-mail address to use from the user’sMywebMethods
profile.

For a group, My webMethods obtains the e-mail addresses for each user in the group from
each user’s My webMethods profile.

For a role, if the role has an “email” attribute that specifies an e-mail address for the role, My
webMethods sends the notification to that e-mail address. Otherwise,MywebMethods obtains
the e-mail addresses for each member of the role from each user’s My webMethods profile.

Note:
If an e-mail address is not available, no notification is sent, for example, if a user has not provided
an e-mail address in their profile. Also note that if the “email” attribute is not available for a
role, MywebMethods only sends notifications to role members if the role is a Static role; it does
not support sending notification to LDAP Query, Database, or Rule-based roles.

For instructions for sharing a workspace, see “Sharing Workspaces” on page 58. For descriptions
of the permissions you can assign, see “Workspace Sharing Permissions” on page 56.

If you grant users “View andModify” and/or “Full Control” permissions, more than one user can
be working in and updating a workspace at the same time. In this case, if two or more users make
changes to the same window in a workspace, the changes made by the user who saves last will
be the changes that are maintained.

Workspace Sharing Permissions
The following table describes the workspace permissions you can assign to a user when sharing
a workspace.
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Use to...Permission

Explicitly deny a user, group, and/or role permission to take any action against
a workspace, including viewing the workspace.

No Permissions

Youmight use this permission if you grant access to a group or role, butwant
to explicitly deny access to one or more users that are in the group or role.

Note:
The owner of the workspace and all users in the Admin role, for example,
sysadmin, always have Full Control permissions to aworkspace regardless
of the actual permission settings.

Grant users the ability to view aworkspace. Users cannot change the content
of the workspace in any way.

View Only

Note:
When you set the permissions for the workspace, the same setting is
assigned to all the windows within the workspace. As a result, if you use
the “View Only” permission, all windows in the workspace are also set to
“View Only”, overriding any custom permissions that have been set for
windows within the workspace. If you want to have a “View Only”
workspace, but allow users tomodify selectedwindows in theworkspace,
first set the workspace permission to “View Only”; then assign custom
permissions for the selected windows in a workspace.

Grant users the ability to view and modify the contents of the workspace.
This permission allows the users to:

View and Modify

View the content of the workspace

Update the layout of a workspace

Update the workspace properties

Rename the workspace

Add content to the workspace

Update the properties of windows in the workspace

Rename windows in the workspace

Resize windows in the workspace

Reposition windows in the workspace

Delete windows from the workspace

Grant users full control over theworkspace. In addition to all the tasks a user
can perform when granted “View and Modify” permissions, the user can
also take the following actions against the workspace:

Full Control
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Use to...Permission

Share the workspace with other users

Delete the workspace

Sharing Workspaces
Use the following procedure to share a workspace with other users, groups, or roles.

Note:
To share a workspace with another user, you must either be the owner of the workspace, or if
you are using aworkspace that another user has sharedwith you, youmust have “Full Control”
permissions for the workspace.

To share a workspace

1. Click on the tab for the workspace and select Share Workspace.

2. In the Workspace Sharing window click Add.

3. Use the Select Principal(s) window to search for and select the users, groups, and roles with
whom you want to share the workspace. When you are done, click Apply to close the Select
Principal(s) window. For more information about using the Select Principal(s) window, see
“Searching for Users, Groups, and Roles” on page 91.

For each selected user, group, and/or role, My webMethods adds a row to the Workspace
Sharing window.

4. For each user, group, and/or role that you selected, select the permissions you want to assign
that user, group, or role from the list in the Permissions column. For more information about
the permissions you can assign, see “Workspace Sharing Permissions” on page 56.

5. If you want to notify the users affected by this change, select the Notify collaborators when
the workspace is shared or unshared check box.

6. Click Apply.

Unsharing Workspaces
Use the following procedure when you no longer want to share a workspace with a user, group,
or role.

Note:
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To stop sharing a workspace with another user, youmust either be the owner of the workspace,
or if you are using a workspace that another user has shared with you, you must have “Full
Control” permissions for the workspace.

To stop sharing a workspace

1. Click on the tab for the workspace and select Share Workspace.

2. In the Workspace Sharing window, select the check box for the users, groups, and/or roles
with which you no longer want to share access to the workspace.

3. If you want to notify the users affected by this change, select the Notify collaborators when
the workspace is shared or unshared check box.

4. Click Delete.

5. Click Apply.

Closing Workspaces

If you no longer need a workspace open, you can close it. When you need to use the workspace
again, you can re-open it. For instructions, see “Opening Workspaces” on page 53.

Note:
If you no longer need the workspace, you can remove it permanently. For instructions, see
“Deleting Workspaces” on page 59.

To close a workspace

Click on the tab for the workspace you want to close, or

Click on the tab for the workspace, and select Close, or

Open the tab finder by clicking and then click in the tab finder for the workspace you
want to close.

Deleting Workspaces

If you no longer need a workspace, you can remove it permanently by deleting it.

Note:
If you just want to temporarily close a workspace because you do not need it open, see “Closing
Workspaces” on page 59.

Note:
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To delete a workspace, you must either be the owner of the workspace, or if you are using a
workspace that another user has shared with you, you must have “Full Control” permissions
for theworkspace. Formore information about sharingworkspaces, see “SharingWorkspaces” on
page 58.

To delete a workspace

On the tab for the workspace, click and select Delete Workspace, or

On the Navigate tab of the navigation pane, right click the workspace name and select Delete
Workspace.

About Adding Workspaces to the Navigation Pane

For easy access to workspaces, you can add them to the Navigate tab in the Workspaces section
of the navigation pane. You can add workspaces that you own and those that other users have
shared with you.

When you no longer need a workspace in the navigation, you can remove it. When you remove
a workspace from the navigation, it is not deleted; the workspace is simply no longer listed in the
navigation pane.

You can organize and group the workspaces in your navigation pane by creating workspace
folders, and then adding the workspaces to your custom folders.

Adding Workspaces to the Navigation Pane
When you add a workspace to the navigation pane, you select the workspace folder in which you
want the workspace to reside.

You can add workspaces to an existing folder, or if you want to use a different folder, add it before
adding the workspace to the navigation pane. You can add the same workspace to the navigation
multiple times if you add it under different folders. For information about adding folders, see
“Adding a Workspace Folder to the Navigation Pane” on page 61.

To add a workspace to the navigation pane

1. In the navigation pane, click the Navigate tab.

2. In the Workspaces section, right click the name of the folder in which you want to add the
workspace and select Add Workspace to Folder.

3. In the Select Workspaces window, search for the workspace you want to add:

a. In the Keyword field, type keywords that My webMethods uses to search for workspaces.
MywebMethodsmatches the keywords you specify againstworkspacenames andkeywords
assigned to the workspaces.
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b. In the Search In field, select the folders in which to look for matching workspaces.

c. Indicate whether you want to search for only workspaces for which you are the owner or
also those that other users have shared with you.

To search only your ownworkspaces, select the Include only workspaces I own check
box.

To search all workspaces towhich you have access, clear the Include only workspaces
I own check box.

d. Click Search.

4. In the Results panel, select the workspace(s) you want to add the navigation pane.

5. Click OK.

Note:
You might need to expand the workspace folder to see the workspaces that you just added
to it.

Removing Workspaces from the Navigation Pane
If you no longer need access to a workspace from the navigation pane, you can remove it. When
you remove a workspace from the navigation, it is not deleted; the workspace is simply no longer
listed in the navigation pane.

To remove a workspace from the navigation pane

1. In the navigation pane, click the Navigate tab.

2. In the Workspaces section, right click the name of the workspace that you want to remove
and select Remove Workspace.

Adding a Workspace Folder to the Navigation Pane
To organize and group workspaces in the navigation pane, you can add workspace folders, and
then add workspaces to the folders. When you add a folder, you select a parent folder for the new
folder. The new folder becomes a subfolder of an existing folder.

To add a workspace folder

1. In the navigation pane, click the Navigate tab.

2. In the Workspaces section, right click the name of an existing folder and select Create New
Folder.

Working with My webMethods 10.11 61

5 Working with My webMethods Workspaces



The new folder will become a subfolder of the selected folder.

3. In the CreateNewFolderwindow in theName of New Folderfield, type a name for the folder.

You can specify from 1 through 255 characters for the name. You can use any characters,
including non-ASCIIs or special characters.

4. Click OK.

Renaming a Workspace Folder in the Navigation Pane
Use the following procedure to rename an existing workspace folder in the navigation pane.

To rename a workspace folder

1. In the navigation pane, click the Navigate tab.

2. In the Workspaces section, right click the name of you want to rename and select Rename
Folder.

3. In the Rename Folder window in the New Name for Folder field, type a new name for the
folder.

You can specify from 1 through 255 characters for the name. You can use any characters,
including non-ASCIIs or special characters.

4. Click OK.

Removing a Workspace Folder from the Navigation Pane
If you no longer need a workspace folder in the navigation pane, you can delete it. When you
delete aworkspace folder,MywebMethods removes the folder and its content from the navigation
pane. If the folder contains workspaces, those workspaces are also removed from the navigation.
The workspaces ares not deleted; they are simply no longer listed in the navigation pane.

To remove a workspace folder from the navigation pane

1. In the navigation pane, click the Navigate tab.

2. In the Workspaces section, right click the name of the folder that you want to remove and
select Delete Folder.

My webMethods removes the folder and its content from the navigation.
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About Workspace Content

You can add the content that you want to a workspace. Typically, you create a workspace to have
one single location to hold information related to a specific issue or topic, and add content related
to that issue or topic. For example, if you are responsible for tracking information related to new
hires for your company, you might create a workspace for each new employee. You can attach
documents related to the new employee, add an image of the new employee, add reminders of
actions you still need to take, etc.

As the owner of a workspace, you can take all actions against windows in a workspace. However,
if you are using a workspace that another user has shared with you, your actions might be limited
based on the permissions the owner of the workspace assigned to you. For example, you might
only be granted the permission to view information and not be allowed to modify it. For more
information about sharing workspaces, see “Sharing Workspaces” on page 58.

Adding Tools to a Workspace

You can add as many tools as you want to a workspace. You can use the same tool multiple times.
For a description of the tools that My webMethods provides as installed, see “Using Tools to
Enhance Workspaces” on page 73.

Note:
To add new content to a workspace you must either be the owner of the workspace, or if you
are using aworkspace that another user has sharedwith you, youmust have “View andModify”
or “Full Control” permissions for theworkspace. Formore information about sharingworkspaces,
see “Sharing Workspaces” on page 58.

To add a tool to a workspace

1. Open the workspace to which you want to add content. For instructions, see “Opening
Workspaces” on page 53.

2. In the navigation pane, click the Tools tab.

3. Drag the tool from the navigation pane on to the workspace in the content area.

4. On the tab for the workspace, click and select Save Workspace.

Adding Windows from Application Pages to a Workspace

You can add windows from application pages to your workspaces. This is useful when the
information in the application pertains to the data you are placing in a workspace. For example,
if you have a workspace to track information about new employees and you have a business
process in place for managing the tasks related to new hires, you might add application page
windows that are related to the new hire business process.
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If the window you want to add to a workspace is wired (connected) to another window on the
application page, My webMethods breaks that connection so that the window can stand alone on
the workspace page. The window keeps its preferences that were set at the time you added it to
the workspace.

For example, if you add a search results window to a workspace, My webMethods breaks the
connection between the search panel and the search results. Its preferences are set to the search
criteria thatwere used to retrieve the search results. The search results panel added to aworkspace
will continue to reflect the results for the search criteria.

If more items match the criteria, the search results will show more items. If less items match the
criteria, the search results will show less items. However, keep in mind that My webMethods
caches search results. So to update the search results in a tab, you must take an action that causes
My webMethods to update the window on the workspace, such as closing and re-opening the
workspace.

Note:
To add new content to a workspace you must be either the owner of the workspace, or if you
are using a workspace that another user has shared with you, you must have View and Modify
orFull Control permissions for theworkspace. Formore information about sharingworkspaces,
see “Sharing Workspaces” on page 58.

To add a window from an application page to a workspace

1. In the navigation pane, click the Navigate tab.

2. In the Applications section, navigate to the page that contains the window you want to add
to a workspace.

3. In the title bar of the window that you want to add to the workspace, click .

4. Click Add to Workspace.

Note:
If awindowon an application page cannot function properly outside of its application page,
the Add to Workspace function is not available.

5. In the Add toWorkspacewindow, search for theworkspace towhich youwant to add content.

a. In the Keyword field, type keywords that My webMethods uses to search for workspaces.
MywebMethodsmatches the keywords you specify againstworkspacenames andkeywords
assigned to the workspaces.

b. In the Search In field, select the folders in which to look for a matching workspaces.

c. Indicate whether you want to search for only workspaces for which you are the owner or
also those that other users have shared with you.
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To search only your ownworkspaces, select the Include only workspaces I own check
box.

To search all workspaces towhich you have access, clear the Include only workspaces
I own check box.

d. Click Search.

6. In the Results panel, select the workspace(s) to which you want to add the window.

7. Click Add.

Adding Windows from a Workspace to Another Workspace

You can addwindows that are in one workspace to another workspace. The window in the source
workspace is not shared with the target workspace. Rather, My webMethods makes a copy of the
window for the targetworkspace. That is, after adding awindow to aworkspace,MywebMethods
does not synchronize the changesmade to the original version in the source window and the copy
in the target window. As changes are made to the window in the source and target workspaces,
they will become different.

Note:
To add new content to a workspace you must either be the owner of the workspace, or if you
are using aworkspace that another user has sharedwith you, youmust have “View andModify”
or “Full Control” permissions to theworkspace. Formore information about sharingworkspaces,
see “Sharing Workspaces” on page 58.

To add a window from a workspace to another workspace

1. In the navigation pane, click the Navigate tab.

2. In the Workspaces section, navigate to the workspace that contains the source window you
want to add to another workspace.

3. In the title bar of the source window, click .

4. Select Add to Workspace.

5. In the Add toWorkspacewindow, search for theworkspace towhich youwant to add content.

a. In the Keyword field, type keywords that My webMethods uses to search for workspaces.
MywebMethodsmatches the keywords you specify againstworkspacenames andkeywords
assigned to the workspaces.

b. In the Search In field, select the folders in which to look for a matching workspace.
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c. Indicate whether you want to search for only workspaces for which you are the owner or
also those that other users have shared with you.

To search only your ownworkspaces, select the Include only workspaces I own check
box.

To search all workspaces towhich you have access, clear the Include only workspaces
I own check box.

d. Click Search.

6. In the Results panel, select the workspace(s) to which you want to add the window.

7. Click Add.

General Properties for a Window in a Workspace

You can open the properties of a window to view or set them. The properties are grouped on tabs.
All windows include a General tab that contains their general properties.

Note:
Some windows also have properties listed on a Preferences tab. The preferences are specific
to the window. See information for the specific window for instructions for viewing and setting
preferences.

The following table lists the general properties, available for each window in a workspace.

DescriptionPropertySection

The name of the window that My webMethods displays
in the window’s title bar.

NameGeneral

For instructions for changing the window name, see
“Renaming a Window in a Workspace” on page 68.

A description for the window.Description

Note:
Currently the description is only listed in the properties
and is not used by My webMethods for any specific
purpose.

For instructions for changing thewindowdescription, see
“Updating the Description of a Window” on page 69.

This property is intended for expert users. It defines the
presentation (view) to use for the window when a user
enters its URL to navigate directly to the window.

Full Page ViewDisplay
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DescriptionPropertySection

This property is intended for expert users. It defines the
presentation (view) to use for the window when viewing
it in a workspace.

Portlet View

The user name of the user that owns the window.OwnerMaintenance

The date and time the window was added to the
workspace.

Created On

The date and time of the last time the window was
updated.

Modified On

This property is intended for expert users. A window can
have zero, one, or more aliases. An alias defines an

Aliases

alternativeway to access awindow.Workspace developers
might need to add aliases if they are building complex
multi-page applications and need to refer to individual
windows, for example,when creating navigation fromone
page to another and need to pass parameters to a specific
window. For more information about aliases, see
Administering My webMethods Server.

Viewing Window Properties

Use the following procedure to view the properties for a window.

To view the properties for a window

1. In the title bar of the window, click .

2. Select Properties.

3. Select the tab for the properties you want to view.

4. Click Cancel to close the properties without making changes.

Renaming a Window in a Workspace

When you add a window to a workspace, My webMethods assigns it a name. You can change its
name by updating the general properties.

Names ofwindowsmust be uniquewithin aworkspace. If you add the samewindowa subsequent
time, My webMethodsappends “(n)” to the name to make the name unique.

Note:
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To update the properties of a window you must either be the owner of the workspace, or if you
are using aworkspace that another user has sharedwith you, youmust have “View andModify”
or “Full Control” permissions for theworkspace. Formore information about sharingworkspaces,
see “Sharing Workspaces” on page 58.

To rename a window in a workspace

1. In the title bar of the window you want to rename, click .

2. Select Properties.

3. Select the General tab.

4. Type a new name in the Name field.

You can specify from 1 through 255 characters for the name. You can use any characters,
including non-ASCIIs or special characters.

5. Click Apply.

6. On the tab for the workspace, click and select Save Workspace.

Updating the Description of a Window

When you add a window to a workspace, by default it has no description associated with it. You
can add a description that appears in the window’s properties.

Note:
To update the properties of a window you must either be the owner of the workspace, or if you
are using aworkspace that another user has sharedwith you, youmust have “View andModify”
or “Full Control” permissions for theworkspace. Formore information about sharingworkspaces,
see “Sharing Workspaces” on page 58.

To update the description of a window

1. In the title bar of the window for which you want to add or update the description, click .

2. Select Properties.

3. Select the General tab.

4. Type a new description in the Description field.

You can specify from 1 through 255 characters for the description. You can use any characters,
including non-ASCIIs or special characters.
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5. Click Apply.

6. On the tab for the workspace, click and select Save Workspace.

Finding Windows in a Workspace

As you add many windows to a workspace, it might take time locating the window you want to
use by scanning the workspace. This is especially true if your workspace uses a free from layout;
in this case, windows might be overlapping hiding the window you want to use. For more
information on workspace layouts, see “Defining the Layout of a Workspace” on page 51.

To locate a specific window and make it the current window, use the window finder. If the
workspace uses a free form layout and the window you want to use is hidden, when you make a
window the current window, My webMethods brings that window to the front.

To find a window in a workspace

1. In the upper, right corner of the workspace click .

2. In the Window Finder, select the name of the window that you want to make the current
window.

Resizing Windows

My webMethods provides many functions to allow you to resize windows within a workspace.
You can:

Minimize a window so that My webMethods displays only the window’s title bar. Use this
function when you do not need to see the content of the window.

Maximize a window so that it uses the full size of the content area. Use this function when
you need more space for a window.

Restore a window to its previous size. Use this function if you previously minimized it and
nowwant to view its content again, or if you previouslymaximized thewindow and no longer
require the window to use the full content area.

Best fit the size of a window so that My webMethods determines the best size to use for a
window.

If you are using a free form layout for the workspace, the window is resized to fit its
contents.

If you are using a column layout (for example,Two Columns), thewindow resizes vertically
to fit the window contents and horizontally to fit the column width.

Customize the size of a window by dragging the edge of the window to make it any size you
want.
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Note:
To resize windows in a workspace you must either be the owner of the workspace, or if you
are using aworkspace that another user has sharedwith you, youmust have “View andModify”
or “Full Control” permissions for the workspace. If you have “View Only” permission to a
workspace, you can resize windows; however, you cannot save the changes. As a result, when
you leave the workspace the windows will revert to their previous state. For more information
about sharing workspaces, see “Sharing Workspaces” on page 58.

To resize a window

To minimize a single window:

In the title bar of a window, click .

In the title bar of the window, click .

To minimize all windows in a workspace, in the upper, right corner of the workspace click

and select Minimize All.

To maximize a window:

In the title bar of a window, click .

In the title bar of the window, click and select Maximize.

To restore a window:

In the title bar of a window, click .

In the title bar of the window, click and select Restore.

To restore all windows in a workspace, in the upper, right corner of the workspace click
and select Restore All.

To automatically resize the window to the best fit, in the title bar of the window, click and
select Auto Size.

To make the window a custom size, drag the edges of the window to the size you want.

Note:
If you are using a column layout for the workspace (for example, Two Columns), and drag
a window larger than the column width, the column width will increase to accommodate
the new width of the window.

After resizing windows, save the workspace to keep your changes by clicking on the tab for the
workspace and selecting Save Workspace.

Positioning Windows in a Workspace

Where you can position windows in a workspace depends on the layout you use for a workspace.
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When using a free form layout, you can move windows anywhere within the workspace.
Windows do not have to be aligned and can overlap one another.

When using a column layout (for example, Three Columns), the layout forces the windows to
be alignedwithin the columns. You canmovewindows up and downwithin a column or from
one column to another.

Note:
To reposition windows in a workspace you must either be the owner of the workspace, or if
you are using a workspace that another user has shared with you, you must have “View and
Modify” or “Full Control” permissions for the workspace. If you have “ViewOnly” permission
to aworkspace, you can repositionwindows; however, you cannot save the changes. As a result,
when you leave the workspace the windows will revert to their previous state. For more
information about sharing workspaces, see “Sharing Workspaces” on page 58.

To position a window in a workspace

1. In the window youwant to reposition, move your cursor over the title bar of the window until
My webMethods displays the move cursor.

2. Click and drag the window to the new location.

3. On the tab for the workspace, click and select Save Workspace.

Deleting Windows from a Workspace

If you no longer need or want a window, you can delete if from the workspace.

Note:
To delete windows from a workspace you must either be the owner of the workspace, or if you
are using aworkspace that another user has sharedwith you, youmust have “View andModify”
or “Full Control” permissions for theworkspace. Formore information about sharingworkspaces,
see “Sharing Workspaces” on page 58.

To delete a window from a workspace

In the title bar of the window, click Tools and select Delete, or

In the upper, right corner of the workspace click and click Delete for the window you
want to remove from the workspace.

After deleting windows, save the workspace to keep your changes by clicking on the tab for the
workspace and selecting Save Workspace.
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MWS Monitoring and Diagnostics Tools

When you add a tool to a workspace, MywebMethods adds a newwindow to the workspace that
is specific to the added tool. For information about working with windows in a workspace, see
“Working with Workspace Content” on page 63.

Note:
To add new content to a workspace you must either be the owner of the workspace, or if you
are using aworkspace that another user has sharedwith you, youmust have “View andModify”
or “Full Permission” permissions for the workspace. For more information about sharing
workspaces, see “Sharing Workspaces” on page 58.

My webMethods provides tools for monitoring and diagnosing. Those tools are available from
the navigation pane, in the MWS Monitoring and Diagnostics section of the Tools tab.

For more information, see Diagnosing My webMethods Server.

The following table provides a brief description of the available monitoring and diagnostics tools.

DescriptionTool

Read and analyze log files created within My webMethods Server.Log Analysis
Datasource

Configure a time period for creating log files withinMywebMethods Server.Log Analysis Time
Period

Set the log message collection criteria.Log Configuration

Analyze and display logs of WARNING, ERROR, or FATAL severity.Log Errors by
Severity

Analyze and display logs only of FATAL severityLog FATAL Issues

Analyze and display logs of WARNING, ERROR, or FATAL severity.Log Issues

Analyze and display logs by the component in which they appear.Log Issues by
Component

Analyze and display logs by the product in which they appear.Log Issues by
Product

View the latest messages in plain text log files of My webMethods Server.Log Viewer

Display statistics about the tenmost used portlets inMywebMethods Server.Most Used
Portlets

Display statistics about the ten most used Web services in My webMethods
Server.

Most Used Web
Services

Debug issues with web service calls from other portlets.SOAP Traffic
Monitor
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DescriptionTool

Measure and analyze the performance of My webMethods Server services
and custom portlets or applications.

Performance
Analysis

Display statistic and analysis information about the performance of various
My webMethods Server actions which are grouped by categories.

Performance
Statistics

Display information about ten of the slowest database calls inMywebMethods
Server.

Slow Database
Calls

Display performance information about ten of the slowest portlets in My
webMethods Server.

Slow Portlets

Display performance information about ten of the slowest Web services in
My webMethods Server.

Slow Web
Services

Provide context information about the Servlet Container forMywebMethods
Server.

Http Information

Monitor the memory usage of the Java Virtual Machine (JVM) and send
notifications to administratorswhen configured threshold limits are reached.

Memory Monitor

Monitor thread execution deadlocks in My webMethods Server threads.Thread Dump

Workspace Tools

When you add a tool to a workspace, MywebMethods adds a newwindow to the workspace that
is specific to the added tool. For information about working with windows in a workspace, see
“Working with Workspace Content” on page 63.

Note:
To add new content to a workspace you must either be the owner of the workspace, or if you
are using aworkspace that another user has sharedwith you, youmust have “View andModify”
or “Full Permission” permissions for the workspace. For more information about sharing
workspaces, see “Sharing Workspaces” on page 58.

My webMethods provides various tools for workspace enhancement. Those tools are available
from the navigation pane, in the Workspace Tools section of the Tools tab.

The following table lists the tools that a typical MywebMethods provides, andwhereto findmore
information about each tool.

Additional informationDescriptionTool

“Attachments Tool” on page 76Attach files to your workspace.Attachments

“Bookmarks Tool” on page 79Add links to workspaces and web
sites.

Bookmarks
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Additional informationDescriptionTool

“Directory Browser Tool” on page 82Find identification information
about otherMywebMethods users.

Directory Browser

“HTML Text Tool” on page 83Add formatted text to a workspace.HTML Text

“Image Tool” on page 84Add an image to a workspace.Image

“Note Tool” on page 86Add simple, unformatted text to a
workspace.

Note

“User Calendar Tool” on page 88Add a user’s calendar to a
workspace.

User Calendar

Attachments Tool

The Attachments tool allows you to attach files to a workspace. For example, if you create a
workspace to track requirements for a new project, you could use the Attachments tool to attach
documents related to the project.

You can select the type of links to use for attached files by setting theAttachments tool preferences.
My webMethods supports two types of links for attached files:

Simple download links. This is the default. With this type of link, when you click a link My
webMethods displays a read-only version of the file. To make changes to the file, you need to
save a copy locally, make your changes, and then update the attached file.

Web Distributed Authoring and Versioning (DAV) URLs. With this type of link, when you
click the linkMywebMethods can typically display a read-write version of the file. As a result,
you can make changes to the file and save them without having to first save the file locally.
To use Web DAV URLs, you must meet the following requirements:

Use the Microsoft Internet Explorer web browser.

For the types of Microsoft office documents that you want to attach, for example, .doc or
.xls, configure the file type to open in a newWindows Explorer window. For more
information, see Microsoft documentation.

Ensure you have installed all Microsoft Office updates for opening files read/write in
Microsoft Internet Explorer and for using Web DAV URLs. For more information, see
Microsoft documentation.

Attaching Files to a Workspace
When using the Attachments tool to attach files, you can:

Browse to select the files you want to attach.

Drag and drop the documents you want to attach into the attachments window.
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Note:
You control whether you can attach files using drag and drop by setting the Attachments
tool preferences. For more information, see “Setting Preferences for an Attachments
Window” on page 78.

After adding the Attachments tool, you can rename the window, reposition it, and resize it. For
more information about managing windows in a workspace, see “Working with Workspace
Content” on page 63.

To attach files to a workspace

1. In the navigation panel, click the Tools tab.

2. In theWorkspace Tools section, drag theAttachments tool on to theworkspace in the content
area.

3. Attach one of more files by doing one of the following:

Browse for and select files you want to add:

1. In the attachments window, click Add.

2. In the Attach Files window, click Browse.

3. Browse to the location of the file to be attached and click Open.

4. If you want to add an additional file, click Attach Another File and repeat the steps
to attach a file.

5. When you have finished selecting all the files you want to attach, click Save.

Drag and drop files you want to add:

Note:
Whether you can use drag and drop is controlled by a property for the attachments
window. You can configure the properties so that MywebMethods does not display the
Drop files here box. For more information, see “Setting Preferences for an Attachments
Window” on page 78.

1. Open a file browser application for your local file system.

2. In the file browser, browse to the location of the files you want to attach.

3. Drag the files you want to attach from the file browser into the Drop files here box in
the attachments window in your workspace.

4. Click Attach.

4. On the tab for the workspace, click and select Save Workspace.
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Setting Preferences for an Attachments Window
The Attachments tool preferences control whether My webMethods:

Uses simple download URLs or Web DAV URLs for attached files. Web DAV files can allow
you tomake updates to attachedfileswithout having to save them locally. Formore information,
see “Attachments Tool” on page 76.

Displays the user interface control that allows you to attach files using drag and drop.

To set properties for an attachments window

1. In the title bar of the attachment window, click .

2. Select Properties.

3. Select the Preferences tab.

4. To indicate the type of links to use for attached files:

Clear the Use Web DAV urls check box to use simple download links.

Select the Use Web DAV urls check box to use Web DAV URLs.

For more information about the differences between simple download links and Web DAV
URLs, see “Attachments Tool” on page 76.

5. If you do not want My webMethods to display the Drop files here box in the attachment
window, clear the Allow Drag n Drop check box. When this check box is cleared, you will not
be able to attach files by dragging them from the file browser.

6. Click Apply.

Updating an Attachment
You can update the files you have listed in the attachments window.

To update an attachment

1. In the attachments window in the row for the attachment that you want to update, click

2. Select Update.

3. In the Update Attachment window, click Browse.

4. Browse to the location of the file you want to use in place of the current file and click Open.
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5. Click Update.

Removing an Attachment
If you no longer want a file attached to the workspace, you can delete it from the attachments
window.

To remove an attachment

1. In the attachments window in the row for the attachment that you want to remove, click .

2. Select Remove.

Bookmarks Tool

The Bookmarks tool allows you to add links to:

External web pages

Other My webMethods workspaces

After adding bookmarks to external web pages and workspaces, you have quick access to them.
To view the page or workspace you only need to click a link in the bookmarks window.

Use the Bookmarks tool to add bookmarks to pages that are related to a workspace. For example,
if you create a workspace to track requirements for a new project and find several web sites that
provide information that youmight want to consider, you can use the Bookmarks tool to add links
to the web sites for easy access to the information.

Adding Bookmarks to a Workspace
When using the Bookmarks tool, you can add bookmarks to:

External web pages by specifying an URL to the page.

Other My webMethods workspaces by searching for and selecting a workspace.

After adding the Bookmarks tool, you can rename the window, reposition it, and resize it. For
more information about managing windows in a workspace, see “Working with Workspace
Content” on page 63.

To add bookmarks to a workspace

1. In the navigation pane, click the Tools tab.

2. In the Workspace Tools section, drag the Bookmarks tool on to the workspace in the content
area.
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3. To add bookmarks to workspaces:

a. Click Add Workspace.

b. In the Select Workspaces window, fill in the following fields to search for the workspaces
for which you want to add bookmarks.

a. In the Keyword field, type keywords that My webMethods uses to search for
workspaces. My webMethods matches the keywords you specify against workspace
names and keywords assigned to the workspaces.

b. In the Search In field, select the folders in which to look for matching workspaces.

c. Select the Include only workspaces I own check box if you only want to search for
workspaces that you own. Clear the check box if you alsowant to search forworkspaces
that others have shared with you.

d. Click Search.

My webMethods displays matching workspaces in the Results panel.

c. In the search results, select the check boxes for the workspaces for which you want to add
bookmarks.

d. Click OK.

4. To add bookmarks to web pages:

a. Click Add Link.

b. In the Title field, type descriptive text for the bookmark.

c. In the Location field, type the URL for the page you want to bookmark.

d. Click Save.

5. On the tab for the workspace, click and select Save Workspace.

Using the Bookmark Tool to Access Bookmarked Pages

To display bookmarked pages

Click the title of the bookmark in the bookmarks window.

Updating a Bookmark Title or URL
After adding bookmarks, you can update the following:
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For a bookmark to a workspace, you can update the title listed for the workspace in the
bookmarks window.

For a bookmark to an external page, you can update the tile and the URL for the external page.

Additionally, you can update whether the workspace or page opens in the same web browser
window or a newwindow. For more information, see “ChangingWhether a Bookmark is Opened
in the Current or NewWindow” on page 81.

To update a bookmark

1. In the bookmarks window in the row for the bookmark that you want to update, click .

2. Select Edit.

3. If you want to change the title My webMethods displays in the bookmarks window, type a
new title in the Name field.

4. For a bookmark to a web page if you want to change the URL, type the new URL in the URL
field.

5. Click Save.

Changing Whether a Bookmark is Opened in the Current or
New Window
You can select whether you want My webMethods to open a workspace and/or external page in
the current window or in a new web browser window.

To change whether a bookmark is opened in the current or new window

1. In the bookmarks window in the row for the bookmark that you want to update, click .

2. Select Edit.

3. If you want the bookmark to open in the current window, in the Open Bookmark part of the
panel select the in current window option.

4. If you want the bookmark to open in a newwindow, in the Open Bookmark part of the panel
select the in a new window option.

5. Click Save.
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Deleting Bookmarks
If you no longer need a bookmark to a workspace or external page, you can delete it from the
bookmarks window.

To delete a bookmark

1. In the bookmarks window in the row for the bookmark that you want to delete, click .

2. Select Delete.

Directory Browser Tool

The Directory Browser tool allows you to find information about other My webMethods users.
The information that you can display is a subset of the identification information from the My
webMethods profile, such as the user ID, full name, e-mail address, instantmessenger user names,
etc.

Add the Directory Browser tool to a workspace if you want quick access to the search window to
find user information. For example, if you create a workspace to track requirements for a new
project and need to contact other users in the project, you can add a directory browser so that you
easily find user information for the other users.

Adding Directory Browsers to Workspaces
To add a directory browser to a workspace, use the following procedure.

After adding the Directory Browser tool, you can rename the window, reposition it, and resize it.
For more information about managing windows in a workspace, see “Working with Workspace
Content” on page 63.

To add a directory browser

1. In the navigation pane, click the Tools tab.

2. In the Workspace Tools section, drag the Directory Browser tool on to the workspace in the
content area.

3. Use the directory browser to search for users, groups, and/or roles. For instructions, see
“Searching for Users, Groups, and Roles” on page 91.

4. On the tab for the workspace, click and select Save Workspace.

82 Working with My webMethods 10.11

7 Using Tools to Enhance Workspaces



HTML Text Tool

The HTML Text tool allows you to add formatted text to a workspace. For example, you can use
different font sizes and styles; make text bold, italics, or underlined; use different colors for the
text; highlight text; align text; add a CSS style sheet; use bullet lists and numbered lists.

Use the HTML Text tool to add text that is related to a workspace. For example, if you create a
workspace to track requirements for a newproject youmightwant to have a bullet list or numbered
list on your workspace to itemize information about the project.

Adding Formatted Text to Workspaces
Use the procedure below to add formatted text to a workspace.

After adding the HTML Text tool, you can rename the window, reposition it, and resize it. For
more information about managing windows in a workspace, see “Working with Workspace
Content” on page 63.

To add formatted text to a workspace

1. In the navigation pane, click the Tools tab.

2. In the Workspace Tools section, drag the HTML Text tool on to the workspace in the content
area.

3. In the new HTML Text window on the workspace, select the Edit Text link.

MywebMethods changes the window to an input mode, displaying the basic formatting tools
at the top of the window.

4. To view the advanced formatting tools, click .

5. Type text in the edit text box using the formatting tools to format the text.

6. Click Apply.

7. On the tab for the workspace, click and select Save Workspace.

Updating Existing Formatted Text
You can update the text in an HTML text window. Use the following procedure to access the edit
mode so that you can update the text.

To update formatted text
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1. In the title bar of the note window, click .

2. Select Properties.

3. Select the Preferences tab.

My webMethods displays the text in edit mode.

4. To view the advanced formatting tools, click .

5. Update the text in the input text box using the formatting tools to format the text.

6. Click Apply.

Image Tool

The Image tool allows you to add an image file to a workspace. You can add any type of image
file that your web browsers supports, for example, .gif, .jpg, .bmp, or .png.

Use the Image tool to add an image that is related to a workspace. For example, if you create a
workspace to track requirements for a new project you might have an image of a screen that is
related to the project and want to display that on the workspace.

To include text with an image, use the HTML Text tool. For more information about that tool, see
“HTML Text Tool” on page 83.

Adding an Image to a Workspace
When using the Image tool, you can add image files by:

Specifying the URL to an image file.

Uploading an image file that resides in your file system.

By default, MywebMethods displays the image using its actual size. However, you can optionally
specify the width and height you want My webMethods to use for the image.

After adding the Image tool, you can rename the window, reposition it, and resize it. For more
information aboutmanagingwindows in aworkspace, see “WorkingwithWorkspace Content” on
page 63.

To add an image to a workspace

1. In the navigation pane, click the Tools tab.

2. In the Workspace Tools section, drag the Image tool on to the workspace in the content area.
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3. In the new Image window on the workspace, select the Click Here link.

4. Identify the image file that you want to add to the workspace:

To identify an image available from an URL:

1. Select the External Url option.

2. In the Image Url field, type the URL for the image you want to add to the workspace.

To identify an image located on your machine:

1. Select the Upload File option.

2. In the Select Image File field, type the path to the image file or click Browse to select
the file.

3. Click Upload File.

5. If you want to define the size of the image in the workspace, perform the following steps.

a. In the Image Height field, type the number of pixels (such as, 80px) or the percentage
(such as, 80%) to use for the height of the image.

b. In the Image Width field, type the number of pixels (such as, 80px) or the percentage (such
as, 80%) to use for the width of the image.

Note:
If you do not specify the size, My webMethods uses the images actual size.

6. Click Apply.

7. On the tab for the workspace, click and select Save Workspace.

Updating an Image in a Workspace
Use the following procedure to update an image displayed in a workspace.

To update an image in a workspace

1. In the title bar of the note window, click .

2. Select Properties.

3. Select the Preferences tab.

4. In the Image Propertieswindow, identify the image file that youwant to add to theworkspace:
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To identify an image available from an URL:

1. Select the External Url option.

2. In the Image Url field, type the URL for the image you want to add to the workspace.

To identify an image located on your machine:

1. Select the Upload File option.

2. In the Select Image File field, type the path to the image file or click Browse to select
the file.

3. Click Upload File.

5. If you want to define the size of the image in the workspace, perform the following steps.

a. In the Image Height field, type the number of pixels (such as, 80px) or the percentage
(such as, 80%) to use for the height of the image.

b. In the Image Width field, type the number of pixels (such as, 80px) or the percentage (such
as, 80%) to use for the width of the image.

Note:
If you do not specify the size, My webMethods uses the images actual size.

6. Click Apply.

Note Tool

TheNote tool allows you to add simple text to aworkspace.With theNote tool, you cannot specify
formatting options for the text. If you need more complex text that requires formatting, such as
using bullet lists, using numbered lists, or specifying font size, style, color, use the HTML Text
tool. For information, see “HTML Text Tool” on page 83.

Use the Note tool to add simple text that is related to a workspace. For example, you might want
to add a short reminder of a task you need to complete for a workspace.

Adding Simple Notes to a Workspace
Use the procedure below to add simple text to a workspace.

After adding the Note tool, you can rename the window, reposition it, and resize it. For more
information aboutmanagingwindows in aworkspace, see “WorkingwithWorkspace Content” on
page 63.

You can also set the preferences for the window to change the background color of the note and/or
add the last update date to the note. For instructions, see “Changing the Background Color of a
Note” on page 87 and “Adding the Last Update Date to a Note” on page 87.
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To add a simple note to a workspace

1. In the navigation pane, click the Tools tab.

2. In the Workspace Tools section, drag the Note tool on to the workspace in the content area.

3. In the new Note window on the workspace, click the default text, “Enter your text here”.

My webMethods changes the window to an edit mode.

4. Type the text you want for the note over the existing text.

5. After specifying your text, click outside of the Note window.

6. On the tab for the workspace, click and select Save Workspace.

Changing the Background Color of a Note
You can update the preferences for the note window to change the background color of a note.

To change the background color of a note

1. In the title bar of the note window, click .

2. Select Properties.

3. Select the Preferences tab.

4. In the Back Ground Color field, select the color you want to use.

5. Click Apply.

Adding the Last Update Date to a Note
You can update the preferences for the note window to add the last date and time the note was
updated.

To add the last update date and time to a note

1. In the title bar of the note window, click .

2. Select Properties.

3. Select the Preferences tab.
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4. Select the Show Last Updated Date check box.

5. Click Apply.

Updating the Text of an Existing Note
You can update the text in a note window. Use the following procedure to access the edit mode
so that you can update the text.

To update the text of an existing note

1. In the note window, click the existing text.

My webMethods changes the window to an edit mode.

2. Type the new text you want for the note.

3. After specifying your text, click outside of the Note window.

4. On the tab for the workspace, click and select Save Workspace.

User Calendar Tool

The User Calendar tool allows you to show the availability of a user by adding the user’s calendar
to a workspace. You can add your own calendar or another user’s calendar.

Note:
User calendars will only show information if an administrator has configured the use of user
calendars for the system and if the user’s e-mail address is configured in the My webMethods
profile.

Adding Your Calendar to a Workspace
To add your user calendar to your workspace use the following procedure.

To add your calendar to a workspace

1. In the navigation pane, click the Tools tab.

2. In the Workspace Tools section, drag the User Calendar tool on to the workspace in the
content area.

By default My webMethods configures the user calendar window to show your user calendar. To
configure the window to display another user’s calendar, see “Changing to View Another User’s
Calendar” on page 89.
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Changing to View Another User’s Calendar
To update a user calendar in a workspace so that it displays the calendar for another user, use the
following procedure.

To change the calendar to display another user’s calendar

1. In the top line of the user calendar window after the user name, click [...].

2. In the Calendar Configuration panel, click Select.

3. Use the Select Principal window to search for and select the user whose calendar you want to
display. For instructions, “Searching for Users, Groups, and Roles” on page 91.

4. After selecting the user, click Apply to close the Select Principal window.

5. In the user calendar window, click Apply.
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About Searching for Users, Groups, and Roles

My webMethods has a standard search panel for searching for users, groups, and/or roles. Many
webMethods applications use this search panel in application pages. Also My webMethods uses
the search panel in workspace tools that require finding a user, group, or role. The following
screenshot shows the search panel.

The search panel might have some differences based on the context of the search. For example:

TheDirectory field is not always included on the search panel. Also,MywebMethods removes
the Directory field when searching for roles.

The Search For field is omitted when you can only search for type, for example, only search
for users.

The Advanced tab is not always included. In this situation the search panel is a single panel
with the search fields from the Keyword tab.

Keyword Searches for Users, Groups, and Roles

Use a keyword search to locate users, groups, or roles that contain the keywords that you specify.

When you initiate a search, you select whether you want to search for users, groups, or roles, and
specify the keywords to use in the search. My webMethods matches the keywords against user
IDs, group IDs, or role IDs based on whether you are searching for users, groups, or roles.

You can use the following special characters in your keywords:

Embed an asterisk (*) any place within a keyword tomatchmultiple characters. The asterisk
functions as a wildcard character. For example, if you want to locate all groups with group
IDs that contain the letter “b” and “c” with any number of characters between, type b*c as the
keyword.

Enclose a keyword in quotations (" ") to match an exact string. For example, if you want to
locate all users with user IDs that contain the string “acct”, type "acct". Note that the search
for exact phrases is case insensitive.

My webMethods performs an AND operation on the keywords you specify. In other words, all
keywords that you specify must be present for My webMethods to include a user, group, or role
in the search results. Additionally, MywebMethods searches as if you had enclosed each keyword
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within asterisks. For example, if you specify the keyword bbb, My webMethods searches as if you
specified *bbb* and returns entries that:

Are equal to the keyword itself, for example, ‘man’ returns ‘man’

Start with the keyword, for example, ‘man” returns ‘manual’ and “manufacturer’

End with the keyword, for example, ‘man’ returns ‘roman’ and “snowman’

Have the keyword embedded, for example, ‘man’ returns ‘romantic’ and ‘adamant’

My webMethods does not take the order in which you specify keywords into consideration. It
returns matching items regardless of the order in which the keywords occur.

Performing a Keyword Search for Users, Groups, or Roles

Use the procedure below to perform a keyword search for users, groups, or roles. Based on the
application page or workspace that includes the panel, the procedure might be slightly different.

To perform a keyword search for users, groups, or roles

1. If the search panel has tabs, select the Keyword tab.

2. In the Search For field, select whether you want to search for Users, Groups, or Roles.

3. If the Directory field is available, select the directory service in which you want to search for
users/groups/roles or select Any Directory to search in all configured directory services.

4. In theKeywords field, type the keywords that youwant to use for your search. For information
about what you can specify, see “Keyword Searches for Users, Groups, and Roles” on page 92.

5. Click Search.

My webMethods displays matching users/groups/roles in the Available list in the panel.

6. Select the users/groups/roles by moving them to the Selected list.

7. Click Add.

Advanced Searches for Users and Groups

If the search panel includes anAdvanced tab, you can use filters for your search.When you initiate
a search, you select whether you want to search for users or groups and then specify one or more
filters. You cannot perform an advanced search for roles.

A filter allows you to specify a field to use for the search and a string value to use for matching.
The Advanced tab of the search panel has a Field Names list that contains the field names you
can use. My webMethods uses Principal Attribute Providers to generate the list of field names. In
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the list, bold items identify the name of the Principal Attribute Provider with the selections
generated from that provider underneath.

The field names in the list can differ based on the webMethods components that are installed.
Additionally, developers at your site can create custom Principal Attribute Providers that can
supply field names for the list.

For each filter, when you select a field, you also specify a string value. A user or group is a match
if the field value for that user or group contains the string value that you specify. The search is
case-insensitive.

My webMethods performs an AND operation on the filters you specify. In other words, all filters
must match for My webMethods to include a user or group in the search results.

Performing an Advanced Search for Users or Groups

Use the following procedure to perform an advanced search for users or groups. Based on the
application page or workspace that includes the search panel, the advanced search might not be
available. When an advanced search is available, the search panel includes an Advanced tab.

To perform an advanced search for users or groups

1. In the search panel, select the Advanced tab.

2. In the Search For field, select whether you want to search for Users or Groups.

3. If the Directory field is available, select the directory service in which you want to search for
users or groups, or select Any Directory to search in all configured directory services.

4. In the Filters section of the panel, specify one or more filters. For each filter, perform the
following steps. For more information about filters, see “Advanced Searches for Users and
Groups” on page 93.

a. Select a field name that you want to use for the search from the Field Name list.

b. In the Value field, type a string contained in the field value of matching users or groups.

c. If you want to add another filter, click and repeat the steps to add a filter.

5. Click Search.

My webMethods displays matching users or groups in the Available list in the panel.

6. Select the users or groups by moving them to the Selected list.

7. Click Add.
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About Searching for Data

MywebMethods has a standard search panel that is included in many application pages to allow
you to search for various types of data, for example, process instances, KPIs, etc. InMywebMethods
the search panels for searching for data do have some slight differences based on the context of
the search. The following screenshot shows a sample panel for searching data.

The two main areas of the search panel are the search bar and the search results.

You use the search bar to define the criteria My webMethods is to use to search for information.
You can also use it to specify options that are specific to the page; for example, you can set an
option to have My webMethods automatically execute a saved search when you access the page.

My webMethods displays the results of the search in the search results area, which is below the
search panel. The search results are in either a standard-format table or in a tree format.

The following table describes the types of searches you can perform, the tab of the search panel
that you use to perform the search, and when the type of search is available for use.

AvailabilitySearch Panel
Tab

DescriptionType of Search

When the keyword
searching is available

KeywordSearch for data that contains the
keywords and/or exact phrases that
you specify.

keyword

depends on the data being
searched.
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AvailabilitySearch Panel
Tab

DescriptionType of Search

For instructions on how to perform
a keyword search, see “Keyword
Searches for Data” on page 98

Whether basic searching is
available depends on the
data being searched.

BasicSearch using basic search criteria
when a keyword search is not
available.

basic

Advanced searching is only
presentwhen the data being

AdvancedSearch using keywords and exact
phrases alongwith additional search

advanced

searched warrants detailedcriteria to produce a detailed search
for specific information. search criteria for specific

information.
For more information, see “Basic
andAdvanced Searches forData” on
page 99.

Re-executing saved searches
is always available from the
search panel.

SavedYou can re-execute searches by
saving the criteria for a search.
When you save a search, you
provide a name for the search

saved

criteria. Then when you want to
re-execute the search, you select the
criteria by the name you assigned it.
You can save and re-execute
keyword and advanced searches.

For instructions on how to save
search criteria and re-execute
searches, see “Saving Your
Search” on page 100

You can set default search options for each My webMethods page that has a search panel. For
example, you can set the tab of the search panel that you want My webMethods to display when
it displays the My webMethods page and whether you want My webMethods to automatically
execute a search when it displays the My webMethods page. For more information, see “Setting
Search Options for a My webMethods Page” on page 102.

My webMethods displays the results of your search in either a standard-format table or a tree
format. You can customize the display of the search results, for example, you can select the columns
you want included in the display. For more information about display options and a description
of standard-format table and tree format, see “Defining HowMy webMethods Displays Search
Results” on page 104.

You can take actions against the items in the search result. For example, if your search was for
logged services data, from the search results, youmight resubmit a service. For more information,
see “Working with Search Results” on page 106.
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Keyword Searches for Data

Use a keyword search to locate entries that contain the keywords and/or exact phrases that you
specify.

When searching for keywords, My webMethods searches across one or more fields. To determine
the fields thatMywebMethods searches, see “Determining the Fields that Keywords are Searched
Against” on page 99. Keyword searches are not case sensitive.

You can use the following special characters in your keywords:

Embed an asterisk (*) any place within a keyword tomatchmultiple characters. The asterisk
functions as a wildcard character. For example, if you want to locate all entries that contain
the letter “b” and “c” with any number of characters between, type b*c as the keyword.

Enclose a keyword in quotations (" ") to match an exact phrase. For example, if you want to
locate all entries that contain the phrase "123 Main Street", type "123 Main Street". Note that
search for exact phrases is case-insensitive.

My webMethods performs an AND operation on the keywords you specify. In other words, all
keywords that you specify must be present for My webMethods to include an entry in the search
results. Additionally, My webMethods searches as if you had enclosed each keyword within
asterisks. For example, if you specify the keyword bbb, MywebMethods searches as if you specified
*bbb* and returns entries that:

Are equal to the keyword itself, for example, ‘man’ returns ‘man’

Start with the keyword, for example, ‘man” returns ‘manual’ and “manufacturer’

End with the keyword, for example, ‘man’ returns ‘roman’ and “snowman’

Have the keyword embedded, for example, ‘man’ returns ‘romantic’ and ‘adamant’

My webMethods does not take the order in which you specify keywords into consideration. It
returns entries regardless of the order in which the keywords occur.

If you do not specify any keywords, My webMethods returns all entries in the search results up
to the defined maximum results allowed. The defined maximum number of search results for a
keyword search is set by My webMethods and is typically 200 results. If you want to define the
maximum number of results, use the Max Results or No Maximum fields on the Options tab.
For more information, see “Setting Search Options for a My webMethods Page” on page 102.

Note:
My webMethods searches across a variety of data sources and databases. Some of the data
sources and databases do not allow searches that contain certain non-alphanumeric characters.
If you specify non-alphanumeric characters in a keyword and the data source or database does
not support searching with those characters, rather than issuing an error and requesting you
retype your keywords, MywebMethods continues with the search. However, MywebMethods
will replace the non-supported character with a wildcard character that matches a single
character. As a result, your search results might include additional entries that do not exactly
match the search criteria you specified.
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Determining the Fields that Keywords are Searched Against

The fields against which My webMethods matches keywords is different based on the page you

are viewing. Use the to determine the fields that My webMethods will use to find matching
entries.

To determine the fields My webMethods searches against

Click or rest your mouse pointer on the icon. My webMethods displays text that lists the
fields that it will search against.

Performing a Keyword Search for Data

Use the following procedure to perform a keyword search for data.

To perform a keyword search for data

1. In the search panel, click the Keyword tab.

2. In the text box, type the keywords that you want to use for your search. For information about
what you can specify, see “Keyword Searches for Data” on page 98.

3. Click Search to initiate the search.

My webMethods displays the results. For more information, see “Defining HowMy
webMethods Displays Search Results” on page 104 and “Working with Search Results” on
page 106.

Tip:
If youwill need to perform this search again in the future, you can save and name the search
criteria. Then to re-execute the search, you simply need to select the search criteria that you
want to execute. For more information, see “Saving Your Search” on page 100.

Basic and Advanced Searches for Data

If the search panel includes a Basic or Advanced tab, you can perform these types of searches.
A basic search is typically available in place of a keyword search. An advanced search is typically
available when a keyword search is available and it provides additional search criteria to allow
you to perform a detailed search for specific information.

The search criteria fields available for basic and advanced searches vary because they include
fields specific to the page you are viewing. For example, assume My webMethods is displaying
the monitoring Process Instances page, which displays information about process instances. The
Advanced tab on the Process Instances page includes fields to allow you to search for specific
process instances; for example, it includes a field that you can use to locate process instances that
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are based on a specific process model and a field that you can use to locate process instances that
have a specific status (for example, completed status).

Although the search criteria on an Advanced tab is specific to the page you are viewing, one field
that is often included on the Advanced tab is a field to specify a time period, for example, a date
and time range to restrict the search. This criterion is called the Range search criterion.

If the data that My webMethods is to search has a time aspect associated with it, the Range list is
available to restrict the search within a specified time period. The Range list contains:

Several options that allow you to select a relative time period (for example, Today, Last 7
days, Last Month)

Custom option that allows you to specify an exact time period.When you selectCustom, you
must also fill in the Start Date, End Date, and Times fields to specify the exact time period.

Important:
If you use the Custom option to specify an exact time period, My webMethods returns data
within the exact time period that you specify. If you add the search results to a workspace, the
data added will be static; that is the data displayed will always be for the exact time period that
you specified. If you want the data to be dynamic, use one of the relative time period options
(for example, Last 7 days). For more information, see “Adding Search Results to a
Workspace” on page 108.

The procedure for performing a basic or advanced search varies based on the page you are viewing.
See the appropriate guide that contains information about the task you are using.

My webMethods returns all entries in the search results up to the defined maximum results
allowed. The defined maximum number of search results for a search is set by My webMethods
and is typically 200 results. If you want to define the maximum number of results, use the Max
Results or No Maximum fields on the Options tab. For more information, see “Setting Search
Options for a My webMethods Page” on page 102.

MywebMethods displays the search results in a table format. Formore information, see “Defining
HowMywebMethodsDisplays SearchResults” on page 104 and “Workingwith SearchResults” on
page 106.

Tip:
If you will need to perform this search again in the future, you can save and name the search
criteria. Then to re-execute the search, you simply need to select the search criteria that you
want to execute. For more information, see “Saving Your Search” on page 100.

Saving Your Search

If you will frequently need to perform the same search, you have the option of saving your search
query. Saving a search query is especially useful when performing advanced searches that you
have constructed with multiple search criteria or search filters. After you save a search, rather
than entering the same search criteria each time you want to execute the search, you can simply
select a saved search and re-execute it. You can save keyword and advanced searches.

Tip:
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As an alternative to or in addition to saving a query, if you want immediate access to your
search results, add the results to a workspace. Each time you display the workspace, the search
results will be available. For more information, see “Adding Search Results to aWorkspace” on
page 108.

To save search criteria that you want to re-execute in the future

1. Perform the search that you want to save. For more information about performing a search,
see one of the following:

“Performing a Keyword Search for Data” on page 99

“Basic and Advanced Searches for Data” on page 99

2. Click Save. My webMethods displays the Save Search dialog box.

3. In the Search Name field, type the name you want to assign to the search.

4. Click OK.

Re-executing a Saved Search
Perform the following procedure to re-execute a search that you previously saved.

To re-execute a saved search

1. Click the Saved tab.

2. Select the search you want to re-execute from the Saved Search list.

Tip:
If you are unsure of the search criteria for the selected search, clickDetails. MywebMethods
displays the saved search criteria.

3. After selecting the search you want to re-execute, click Search.

Modifying a Saved Search
You can modify the search criteria for a saved search and re-save the search to keep your
modifications.

To modify the search criteria for a saved search

1. Click the Saved tab.
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2. Select the search you want to re-execute from the Saved Search list.

3. Click Details. My webMethods displays all search criteria including both:

Search fields that you specified when you saved the search so that you can change them
if necessary. My webMethods displays your current settings in these search fields.

Search fields that you did not previously set, but might want to set when changing your
search criteria.

4. Make your changes to the search criteria.

5. To save your changes, click Save.

Deleting a Saved Search
If you no longer need a saved search, you can delete it.

To delete a saved search

1. Click the Saved tab.

2. Select the search you want to delete from the Saved Search list.

Tip:
If you are unsure of the search criteria for the selected search, clickDetails. MywebMethods
displays the saved search criteria.

3. After selecting the search you want to delete, click Delete.

Setting Search Options for a My webMethods Page

For each My webMethods page that has a search panel, you can define search options that apply
specifically to that page. These search options can include:

The search panel tab (for example, Keyword or Advanced) you want My webMethods to
display by default when you initially access the My webMethods page

Whether youwantMywebMethods to automatically execute a searchwhen you initially access
the My webMethods page, and if so, the saved search you want My webMethods to execute

The maximum number of search results that you want My webMethods to retrieve before
stopping execution of a search

To set search options for a My webMethods page

1. Access the My webMethods page for which you want to set search options.
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2. Click the Options tab.

3. To define the search panel tab you want My webMethods to display when you initially access
the My webMethods page, use the Search Tab field. Select one of the available options.

The following table lists the available search options.

DescriptionOption

My webMethods displays the Keyword tab.Keyword

My webMethods displays the Basic tab.Basic

My webMethods displays the Advanced tab.Advanced

My webMethods displays the Saved tab.Saved

My webMethods displays the Saved tab with the fields that show the
details about the saved search criteria displayed.

Saved - Details

4. To select a saved search to load, and optionally execute, use the Selected Saved Search field
and the Run selected saved search when window is displayed check box:

a. Use the Selected Saved Search field to identify a saved search you want loadedwhen
you initially access the My webMethods page.

If you do not select the Run selected saved search when window is displayed check
box, which is described in the step below,MywebMethods does not automatically execute
the search when you access theMywebMethods page; it will execute the search when you
click Search. If you set the Search Tab field to Saved or Saved - Details, when you
initially access thisMywebMethods page, MywebMethods displays the saved search that
you select on this tab.

If you do not select a saved search in the Selected Saved Search field, My webMethods
will not load nor execute a search when you initially access the page.

b. If you want My webMethods to execute the saved search that you selected in the Selected
Saved Search field, select the Run selected saved search when window is displayed
check box. When you select this check box, My webMethods automatically executes the
selected saved search when you access the My webMethods page and displays its results,
regardless of your setting in the Search Tab field.

5. Define themaximumnumber of search results thatMywebMethods retrieves before stopping
the execution of a search by selecting one of the following options:

Max Results - enter the maximum number of search results to retrieve. Use this option to
retrieve only the most recent information. Setting a maximum number of results also
increases the speed of searches.
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No Maximum - select the checkbox to specify unlimited results for a search. Setting
unlimited resultsmight significantly increase the time forwhichMywebMethods retrieves
and displays the search results.

6. Click Save to save your search options.

Defining How My webMethods Displays Search Results

My webMethods displays search results in a table format. Whether display options are available
at all and which options you can use depend on the page that My webMethods is displaying.

The following table lists the display options for search results andwhere to findmore information
about each option.

DescriptionDisplay Option

Sort order of search results Define the default sort order for
search results.

Re-sort search results after My
webMethods initially displays the
results.

For more information, see: “Sorting the
Search Results” on page 104

Define the number of rows to use for
displaying search results.

Number of search results rows

For more information, see “Defining the
Number of Search Results Rows to
Display Per Page” on page 105

Define the columns to use in the search
results and the order in which the
columns appear.

Columns displayed

For more information, see “Setting the
Columns to Display and Their Display
Order” on page 106

Sorting the Search Results
For each My webMethods page that contains a search panel, you can sometimes define a default
sort order thatMywebMethods useswhendisplaying search results. The default applies specifically
to that page.Whether you can specify a sort order depends on the page. You can determinewhether
you can set a sort order by the presence of absence of the sort fields described in the procedure
below.
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After My webMethods displays search results in your selected default sort order, you can still
re-sort the search results.

To set the default sort order for search results on a specific a My webMethods page

1. Access the My webMethods page for which you want to set display options.

2. In the search results panel window, click and select Properties.

3. Click the Preferences tab.

4. In the Sort By field, select the column name that you want to use to sort the search results.

5. For Sort Order select either Ascending or Descending to specify the sort order.

6. Click Apply.

Resorting the Search Results

To re-sort the search results

To re-sort the search results, click in the column heading of the column that you want to use

to sort the search results. My webMethods indicates the current sort order by displaying or

next to the column header of the column that is currently being used for sorting:

indicates the results are sorted in ascending order

indicates the results are sorted in descending order.

For example, if your search results contain a column labeled PROCESS and you want to sort
the data alphabetically based on the process name, click in the PROCESS column heading.

Defining the Number of Search Results Rows to Display Per
Page
You can set the number of rows that My webMethods displays on each page of the search results.
For example, if a search produces 18 results and you define the number of rows to display per
page as 10, My webMethods displays your results in 2 pages, 10 results on the first page and the
remaining 8 results on the second.

Tip:
If you want to take the same action against all results from a search, set the number of rows to

show all. Then, you can use to select all items in the search results, allowing you to act on
all items at one time. For example, you might want to do this if you need to perform a bulk
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delete of several items. For more information about acting on search results, see “Taking Action
Against Items in the Search Results” on page 107.

To define the number of search results rows to display per page

1. Access the My webMethods page for which you want to set display options.

2. In the search results panel window, click and select Properties.

3. Click the Preferences tab.

4. In theNumber of Rows to Displayfield, select the number of rows youwantMywebMethods
to use when displaying search results on this My webMethods page.

5. Click Apply.

Setting the Columns to Display and Their Display Order
For each My webMethods page, you can customize the columns that My webMethods displays
in the search results. Additionally, you can specify the order in which you want the columns to
appear.

To customize the display of columns for the search results

1. Access the My webMethods page for which you want to set display options.

2. In the search results panel window, click and select Properties.

3. Click the Preferences tab.

4. To specify the columns that you want included, in the Column Display section of the panel,
move the columns to the Selected box.

5. To specify the order in which My webMethods displays the columns in the search results,
move the column names up and/or down in the list.

6. Click Apply to save your column display changes.

Working with Search Results

The following table lists how you can use the search results, and where to find more information
about how to work with search results.
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Additional informationTask

“Taking Action Against Items in the Search
Results” on page 107

Perform actions against items returned in the
search results. For example, edit an entry.

“Adding Search Results to a Workspace” on
page 108

Add the search results to a workspace.

“Exporting Search Results to a .csv File” on
page 109

Export the search results to a comma-delimited
text file (.csv file).

Taking Action Against Items in the Search Results
Typically, you will be able to perform actions against items listed in the search results. Actions
that might be available can fall into one of three categories:

Actions against multiple items in the search results (for example, deleting one or more items)

Action to add an item

Actions against a single item in the search result (for example, editing an item or displaying
details about an item)

For information about the actions available in a specific search panel and more details about how
to perform the actions, see the appropriate guide that is associated with the task.

Taking Action Against Multiple Items in the Search Results

If you can take actions against multiple entries in the search results, My webMethods displays a
function bar at the top of the search results. The function bar contains a button for each action you
can perform. For example, on the Monitoring > Business > Process Instances page, there is a
Resubmit button that allows you to resubmit one or more process instances. In the search results,
you mark each process instance that you want to resubmit, and then click Resubmit.

To act against multiple items in the search results

1. Select the items by selecting their check boxes.

To select all items on the currently displayed page of the search results, click . To clear all

items that you have selected on the currently displayed page, click .

2. After selecting the items youwant to act on, click the appropriate button (for example,Delete)
in the function bar.

Tip:
If youwant to take the same action against all results from a search, first update the number
of rows to display in the search results to show all search results on a single page. Then,
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you can use to select all items in the search results, allowing you to act on all items at
one time. For information about setting your preference, see “Defining theNumber of Search
Results Rows to Display Per Page” on page 105.

Adding Items

If you can add an item,MywebMethods displays a button you can use to add items in the function
bar. For example, on the Monitoring > System-Wide > Rules > Rule List page, there is a Create
Rule button. To add a new rule, click Create Rule.

To add an item

Click the add button, which is typically labeled Add or Create.

IfMywebMethods displays additionalwindows, supply the requested information to describe
the new item you are adding.

Taking Action Against a Single Item in the Search Results

If you can take actions against individual items in the search results, My webMethods displays
action icons in the rows for items. The action icons are displayed on the right unless you re-ordered
the column displays to place them in a different location.

Two common action icons are the icon that you use to edit information for an item in the search
results and the icon that you use to display detail information for an item in the search results.

To act against a single item in the search results

Click on the appropriate icon for the item you want to act on.

Adding Search Results to a Workspace
You can add the search results to a workspace.

Important:
If your search includes a criterion that specifies an exact time period, for example using the
Custom selection of theRange search criterion,when you add the search results to aworkspace,
the data is static; that is the data displayed will always be for the exact time period that you
specified. For more information about the Range search criteria, see “Basic and Advanced
Searches for Data” on page 99.

To add search results to a workspace

1. In the title bar of the window containing the search results that you want to add to the
workspace, click .

108 Working with My webMethods 10.11

9 Searching for Data



2. Select Add to Workspace.

3. In the Add to Workspace window, search for the workspace to which you want to add the
search results.

a. In the Keyword field, type keywords that My webMethods uses to search for workspaces.
MywebMethodsmatches the keywords you specify againstworkspacenames andkeywords
assigned to the workspace.

b. In the Search In field, select the folders in which to look for a matching workspace.

c. Indicate whether you want to search for only folders for which you are the owner or also
those that other users have shared with you.

To search only your ownworkspaces, select the Include only workspaces I own check
box.

To search all workspaces towhich you have access, clear the Include only workspaces
I own check box.

d. Click Search.

4. In the Results panel, select the workspace(s) to which you want to add the search results.

5. Click Add.

Exporting Search Results to a .csv File
You can export search results to a a comma-delimited text file (.csv file) if the search results panel
includes the Export Table function.

The Export Table function exports columns that are hidden (data-only) or rendered on the screen
when those columns are marked as exportable. Columns that are not rendered on the screen are
omitted from the output, even when they are marked as exportable.

After exporting search results to a .csv file, you can then import the .csv file into Microsoft Excel,
Microsoft Access, or any other application that accepts the .csv file format.

To export search results

1. Click Export Table, which is located in the top right of the search results.

2. From the Character Encoding list, select the character encoding to use.

3. Click Export.

4. Click Save to indicate you want to save the search results to a file.
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5. In the Save As dialog box, browse to the location where you want to save the .csv file.

6. Click Save.
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